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Module 1: Basics of Solids Modeling with SolidWorks 
 
Introduction 
SolidWorks is the state of the art in computer-aided design (CAD). SolidWorks 
represents an object in a virtual environment just as it exists in reality, i.e., having volume 
as well as surfaces and edges. This, along with exceptional ease of use, makes 
SolidWorks a powerful design tool. Complex three-dimensional parts with contoured 
surfaces and detailed features can be modeled quickly and easily with Solid-Works. 
Then, many parts can be assembled in a virtual environment to create a computer model 
of the finished product. In addition, traditional engineering drawings can be easily 
extracted from the solids models of both the parts and the final assembly. This approach 
opens the door to innovative design concepts, speeds product development, and 
minimizes design errors. The result is the ability to bring high-quality products to market 
very quickly. 
 
CONSTRAINT-BASED SOLIDS MODELING 
The constraint-based solids modeling used in SolidWorks makes the modeling process 
intuitive. The 3-D modeling begins with the creation of a 2-D sketch of the profile for the 
cross section of the part. The sketch of the cross section begins much like the freehand 
sketch of the face of an object. The initial sketch need not be particularly accurate; it 
needs only to reflect the basic geometry of the part’s cross-sectional shape. Details of the 
cross section are added later. The next step is to constrain the two-dimensional sketch by 
adding enough dimensions and parameters to completely define the shape and size of the 
two-dimensional profile. The name constraint-based modeling arises because the shape 
of the initial two-dimensional sketch is “constrained” by adding dimensions to the sketch. 
Finally, a three-dimensional object is created by revolving or extruding the two-
dimensional sketched profile. Figure 1 shows the result of revolving a simple L-shaped 
cross section by 270o about an axis and extruding the same L-shaped cross section along 
an axis.  

Axis 

Figure 1 Revolved and extruded solid models of an L-shaped cross-section. 
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In either case, these solid bodies form the basic geometric solid shapes of the part. Other 
features can be added subsequently to modify the basic solid shape. Once the solids 
model is generated using SolidWorks, all of the surfaces have been automatically 
defined, so it is possible to shade it in order to create a photorealistic appearance. It is 
also easy to generate two-dimensional orthographic views of the object. Solid modeling 
is like the sculpting of a virtual solid volume of material. Because the volume of the 
object is properly represented in a solids model, it is possible to slice through the object 
and show a view of the object that displays the interior detail (sectional views). Once 
several solid objects have been created, they can be assembled in a virtual environment to 
confirm their fit and to visualize the assembled product. Solids models are useful for 
purposes other than visualization. The solids model contains a complete mathematical 
representation of the object, inside and out. This mathematical representation is easily 
converted into specialized computer code that can be used for stress analysis, heat-
transfer analysis, fluid-flow analysis, and computer-aided manufacturing. 

Getting Started in SolidWorks 
Introduction and Reference 
 
SolidWorks Corporation developed SolidWorks® as a three-dimensional, feature-based, 
solids-modeling system for personal computers. Solid modeling represents objects in a 
computer as volumes, rather than just as collections of edges and surfaces. Features are 
three-dimensional geometries with direct analogies to shapes that can be machined or 
manufactured, such as holes or rounds. Feature-based solid modeling creates and 
modifies the geometric shapes of an object in a way that represents common manufactur-
ing processes. This makes SolidWorks a very powerful and effective tool for engineering 
design. 

As with other computer programs SolidWorks organizes and stores data in files. Each file 
has a name followed by a period (dot) and an extension. There are several file types used 
in SolidWorks, but the most common file types and their extensions are 

 Part files .prt or .sldprt 
 Assembly files .asm or .sldasm 
 Drawing files .drw or .slddrw 

Part files are the files of the individual parts that are modeled. Part files contain all of the 
pertinent information about the part. Because SolidWorks is a solids-modeling program, 
the virtual part on the screen will look very similar to the actual manufacture part. 

Assembly files are created from several individual part files that are virtually assembled 
(in the computer) to create the finished product.  

Drawing files are the two dimensional engineering drawing representations of both the 
part and assembly file. The drawings should contain all of the necessary information for 
the manufacture of the part, including dimensions, part tolerances, and so on. 

The part file is the driving file for all other file types. The modeling procedure begins 
with part files. Subsequent assemblies and drawings are based on the original part files. 
One advantage of SolidWorks files is the feature of dynamic links. Any change to a part 
file will automatically be updated in any corresponding assembly or drawing file. 
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Therefore, both drawing and assembly files must be able to find and access their 
corresponding part files in order to be opened. SolidWorks uses information embedded 
within the file and the filename to maintain these links automatically. 

Starting SolidWorks 
SolidWorks runs on computers running the Microsoft Windows® operating system. You 
open SolidWorks in the same way that you would start any other program. 

Checking the Options Settings 
The SolidWorks window that appears on the computer screen looks similar to the 
standard Microsoft Windows interface, as shown in Figure 2. The top line of the window 
is the Menu bar from which menus for various operations can be opened. Below the 
Menu bar are the toolbars which provide access to a variety of commonly used 
operations, or tools, with a single click of the mouse button. Toolbars can also extend 
down the right and left sides of the window. They may or may not be shown on your 
screen. At this point, most items within the toolbars are grayed out. This indicates that 
they are not presently available for use. 

 
Figure 2 SolidWorks window. 
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Tool bars  
To specify which toolbars are displayed on the screen, select View Tool-bars (i.e., select 
Toolbars from the View menu). Be sure that the Features, Sketch, Standard, Standard 
Views and View toolbars are checked, as shown in Figure 3. If they are not, click on each 
of these items until all are checked. If other toolbars are checked, click on them to 
uncheck them. It may be necessary to select View, then Toolbars again to display the 
menu after checking (or un-checking) an item to confirm that the desired change was 
made. The Standard Views toolbar may appear as a dialog box in the Graphics Window 
instead of as a toolbar. If so, click the blue bar at the top of the dialog box with the left 
mouse button and drag it to the toolbar at the upper right of the Graphics Window. 
Release the mouse button. The dialog box should change to a toolbar. 

 
Figure 3Toolbars menu. 

• The Sketch  toolbar contains tools to draw lines, circles, rectangles, arcs, and so 
on. 

• The Features toolbar contains tools that modify sketches and existing features 
of a part. 

• The Standard toolbar contains the usual commands available for manipulating 
files (Open, Save, Print, and so on), editing documents (Cut, Copy, and Paste), 
and accessing Help. 
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• The Standard Views toolbar contains common orientations for a model. 

• The View toolbar contains tools to orient and rescale the view of a part. 

You can find these toolbars around the Graphics Window by checking and un-checking 
them in the View⇒Toolbars menu. The toolbars will appear as you check them and 
disappear as you uncheck them. Currently, most of the items in the tool-bars are grayed 
out, since they are unusable. They will become active when they are available for use. Be 
sure that the Toolbars menu looks like the one in Figure 3 before continuing. Click any 
open spot in the Graphics Window to close all menus. 

Getting Help 
If you have questions while you are using SolidWorks, you can find answers in several 
ways: 

• Click SolidWorks Help Topics in the Help Menu bar. 

• Move the cursor over a toolbar button to see the ToolTip, which indicates the 
name of the tool. 

• Move the cursor over buttons or click menu items. The Status bar at the bottom 
of the SolidWorks window will provide a brief description of the function. 

• Click the Help button in a dialog box. 

• Refer to the Solid Works User’s Guide, by SolidWorks Corporation, for detailed 
information. 

Creating a New Part 

With the SolidWorks window open, select File⇒New in the Menu bar, or click the New 
button (a blank-sheet icon) in the Standard toolbar. 

The New Solid Works Document dialog box appears as shown in Figure 4. You will be 
modeling a new part. If Part is already highlighted, click OK. If it is not highlighted, 
click Part, then OK.  
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                          Figure 4 New document window.    

A new window appears with the name Partl, as shown in Figure 5. On the left side of the 
window is the Feature Manager Design tree.  

 

Sketch toolbar 

Figure 6 New part window. 
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It contains a list of the features that have been created so far. Every new part starts with 
six features: annotations, lighting, three datum planes, and an origin. The datum planes 
are three mutually perpendicular planes that are created in space as references for 
constructing features of the part that you are modeling. The three planes intersect at the 
origin, which is in the center of the Graphics Window. The arrows in the lower left corner 
of the Graphics Window show the coordinate directions. As the part is modeled, the 
features that are created will appear in the Feature Manager Design tree. These features 
can be highlighted or modified by clicking on them in the Feature Manager Design tree. 
For example, click on a plane or the origin in the Feature Manage Design tree to highlight 
these items. Front is the plane of the screen, Top is the horizontal plane perpendicular to 
the screen, and Right is the vertical plane perpendicular to the screen. Finish by clicking 
on Part1 in the Feature Manager Design tree, so that no plane is highlighted. 

Sketching 
Every part begins as a cross section sketched on a two-dimensional plane. Once a sketch 
is made, it is extruded or revolved into the third dimension to create a three-dimensional 
object. This is the base feature of the part.  

The Sketch toolbar, shown in Figure 6, has tools to set up and manipulate a sketch of a 
cross section. Find the Sketch toolbar. Move the cursor over each of the tools, but do not 
click on any of the tools. The Tool Tips should appear, displaying the name of each tool. 

• Select highlights sketch entities; drags sketch entities and endpoints and 
modifies dimension values. 

• Grid activates the Grid/Snap field of the Document Properties dialogue box to 
change the sketching environment. 

• Dimension adds dimensions to sketch entities. 

• Sketch opens and closes sketches as a part is created. 
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                 Figure 6 Document properties dialog box: Units  

 

To set the units and grid size to be used, click the Grid toolbar button with the left mouse 
button. Document properties dialog box shown in Figure 6 will appear. Click Units on 
the left side of the dialog box to set the units. Setup appropriate units (inches or mm) with 
the desired number of decimal places or fraction denominator.  

Click Grid/Snap on the left side of the dialogue box to control the grid that will appear 
on the screen when a cross-section is sketched. Be sure that all three of the boxes under 
Grid are checked, as shown in Figure 7. Adjust the grid spacing to desired values. 
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         Figure 7 Document properties dialog box: Grid/Snap 

 

Snap controls the way in which sketched lines are related to the grid. The points that are 
sketched should “snap” to the nearest intersection of grid lines when they are close. Click 
Go To System Snaps. If not, click the box Grid to check it as shown in Figure 8. 
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Figure 8 Document properties dialog box: System Snap  

Click Detailing on the left side of tile dialogue box. If necessary, change Dimensioning 
standard to ANSI for inch units and ISO in case of mm units. Then, click OK at the 
bottom of the dialogue box to accept the values. 

Open a new sketch by selecting Insert Sketch, or by clicking the Sketch button (a 
pencil drawing a line) in the Sketch toolbar. (Note that, for most commands in 
SolidWorks, it is possible to initiate the command from either the Menu bar or the 
toolbars.) A grid should appear on the screen, as shown in Figure 9, indicating that the 
sketch mode is active. The window’s name changes to Sketch of Part1. In the bottom 
right corner of the screen, the Status bar reads Editing Sketch. You are now ready to 
sketch in the Front plane. 

The Sketch toolbar, shown in Figure 9, contains tools to create and modify two-
dimensional features, called Sketch Entities. Sketch Entities are items that can be drawn 
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on the sketch. The following Sketch Entities and Sketch Tools are available: 

 
Figure 9 New sketch window. 

 

• Line  creates a straight line. 

• Centerpoint Arc  creates a circular arc from a center point, a start point, 
and an end point. 

• Tangent Arc  creates a circular arc tangent to an existing sketch entity. 

• 3 Pt Arc  creates a circular arc through three points. 

• Circle  creates a circle. 

• Spline creates a curved line that is not a circular arc. 

• Polygon creates a regular polygon. 

• Rectangle  creates a rectangle. 

• Point  creates a reference point that is used for constructing other sketch 
entities. 
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• Centerline  creates a reference line that is used for constructing other sketch 
entities. 

• Convert Entities  creates a sketch entity by projecting an edge, curve, or 
contour onto the sketch plane. 

• Mirror  reflects entities about a centerline. 

• Fillet  creates a tangent arc between two sketch entities by rounding an 
inside or an outside corner. 

• Offset Entities  creates a sketch curve that is offset from a selected sketch 
entity by a specified distance. 

• Trim  removes a portion of a line or curve. 

• Construction Geometry creates entities that aid in sketching. 

• Linear Sketch Step and Repeat creates a linear pattern of sketch entities. 

• Circular Sketch Step and Repeat creates a circular pattern of sketch entities. 

Move and hold the cursor over each of the tools to display its function but do not click on 
the tool. Note the description of each tool in the Status bar at the bottom of the 
SolidWorks window. Some of these tools may not he included in the toolbar or other 
tools may be available, depending on the way in which it was previously set up. All tools 
are available in the Tools Menu. 
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Module 2a: Basic Sketching I 
In this tutorial, you will draw the sketch of the model shown in Figure 1. The sketch is shown 
in Figure 2. You will not dimension the sketch. The solid model and the dimensions are given 
only for your reference.  

 
 Figure 1 Solid model   Figure 2 Sketch for the solid model 
The steps that will be followed to complete this tutorial are listed below:  

1. Start SolidWorks and then start a new part document.  

2. Maximize the part file document and then switch to the sketching environment.  

3. Draw the sketch of the model using the Line and the Circle tools, refer to Figures 4 
through 7.  

4. Save the sketch and then close the document.  

Starting SolidWorks and Starting a New Part Document  

1. Start SolidWorks by choosing Start> Programs> SolidWorks 2005 > SolidWorks 

2005 or by double-clicking the shortcut icon  of SolidWorks available on the 
desktop of your computer.  

2. The SolidWorks 2005 window is displayed. Choose the New Document option from 
this window. The New SolidWorks Document dialog box is displayed.  

3. The Part button is chosen by default. Choose the OK button from the New 
SolidWorks Document dialog box as shown in Figure 3. A new SolidWorks part 
document will be opened. But the part document window will not be maximized in 
the SolidWorks window.  
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Figure 3 New SolidWorks document dialog box. 

4. Choose the Maximize  button available on the upper right corner of the part 
document window to maximize the document window. When you open a new part 
document, the part modeling environment is active by default. As you first need to 
draw the sketch of the feature, you need to invoke the sketching environment.  

5. Select the Front plane.  

6. Choose the Sketch  button from the Standard toolbar. The Sketch tools toolbar 
becomes highlighted. The sketching environment is invoked and the plane is oriented 
normal to the view i.e., parallel to screen. You will notice that a red color origin is 
displayed in the center of the screen, indicating the sketching environment. The 
default screen appearance of the sketching environment of SolidWorks is shown in 
Figure 4.  
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Figure 4 Starting a new sketch. 

Setting the Units and Grid  

1. Choose Tools> Options from the menu bar to invoke the System Options -General 
dialog box.  

2. Choose the Document Properties tab. The name of the dialog box is changed to the 
Document Properties -Detailing dialog box.  

3. Select the Units option from the area on the left to display the options related to linear 
and angular units.  

4. Select millimeters from the drop-down list available in the Length units area. Also, 
select the Degrees option from the drop-down list provided in the Angular units area.  

5. Select Grid/Snap from the area on the left. Set the value of the Major grid spacing 
spinner to 100 and the value of the Minor-lines per major spinner to 10.  

6. Select the Go to System Snaps, check Grid box in the Sketch Snap area, if it is 
cleared. Choose OK to exit the dialog box.  

Drawing the Outer Loop of the Sketch  
It is a good practice to draw the sketch on one side of the origin, preferably in the first 
quadrant. This is because while generating the part program for manufacturing the part, you 
will have a reference for work origin in advance.  

The sketch of the model consists of an outer loop, two circles inside the outer loop, and a 
cavity. Therefore, it will be drawn using the Line and the Circle tools. You will first draw the 
outer loop and then the inner entities. Note that in the sketcher environment, the lower right 
corner of the SolidWorks window displays three areas. The first area displays the X, Y, and Z 
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coordinates of the current location of the cursor. These coordinates will be modified as you 
move the cursor around the drawing area. You will use the coordinate display to draw the 
sketch of the model.  

You will start drawing the sketch from the lower left corner of the sketch and the outer; loop 
will be drawn using the continuous lines.  

1. Click Line  button on the Sketch toolbar to invoke the Line tool. The arrow cursor 
will be replaced by the line cursor.  

2. Move the cursor in the first quadrant close to the origin. The coordinates of the point 
are displayed close to the lower right corner of the screen.  

3. Press the left mouse button at the point whose coordinates are 10 mm 10 mm 0 mm 
and then move the cursor horizontally toward the right.  

You will notice that the symbol of Horizontal relation is displayed below the line 
cursor and the length of the line is displayed above the line cursor. As the length of 
the first horizontal line at the lower left comer is 10 mm, you will move the mouse 
until the length of the line is shown as 10 above the line cursor.  

4. Press the left mouse button when the length of the line that is displayed above the line 
cursor shows a value of 10.  

The first horizontal line is drawn. Because you are drawing continuous lines, the 
endpoint of the last line is automatically selected as the start point of the next line.  

5. Move the line cursor vertically upward. The symbol of Vertical relation is displayed 
below the line cursor and the length of the line is displayed above the line cursor.  

6. Press the left mouse button when the length of the line displayed above the line cursor 
shows a value of 10.  

A vertical line of length 10 mm will be drawn and will be displayed in green color. 
Also, as this is the line that is selected now, the previous line will no more be 
highlighted and therefore will be displayed in blue color.  

7. Move the line cursor horizontally toward the right. Press the left mouse button when 
the length of the line above the line cursor shows a value of 10. This draws the next 
horizontal line of 10 mm length.  

8. Move the line cursor vertically downward and press the left mouse button when the 
length of the line on the line cursor shows a value of 10.  

9. Move the line cursor horizontally toward the right and press the left mouse button 
when the length of the line on the line cursor shows a value of 30.  

10. Move the line cursor vertically upward and press the left mouse button when the 
length of the line on the line cursor shows a value of 10.  

11. Move the line cursor horizontally toward the right and press the left mouse button 
when the length of the line on the line cursor shows a value of 10.  

12. Move the line cursor vertically downward and press the left mouse button when the 
length of the line on the cursor shows a value of 10.  

13. Move the line cursor horizontally toward the right and press the left mouse button 
when the length of the line on the line cursor shows a value of 10. 
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14. Move the line cursor vertically upward and press the left mouse button when the 
length of the line on the line cursor displays a value of 40.  

The next line that you will draw is an inclined line that makes an angle of 135°. To 
draw this line, you will move the cursor in a direction that makes an angle of 135°.  

The aligned length of the line is not given for this line. Instead, the delta X and delta 
Y values are given. Therefore, you will draw a line at this point such that the delta X 
and delta Y value of this line is 10 mm each. These values can be viewed in the Line 
Property Manager. The last spinners in the Line PropertyManager are for the delta 
values.  

15. Move the line cursor such that the line is drawn at an angle of 135-degree. The current 
angle will be displayed in the spinner above the delta spinners in the Line 
PropertyManager.  

16. Press the left mouse button when the delta X value in the Delta X spinner shows a 
value of 10 and the value of delta Y in the Delta Y spinner displays a value of 10 in 
the Line Property Manager. At this stage, the length of the line will be displayed as 
14.14 above the line cursor and also in the Length spinner in the Line 
PropertyManager.  

17. Move the line cursor horizontally toward the left and press the left mouse button when 
the length of the line on the line cursor displays a value of 50.  

You will notice that some blue and brown inferencing lines are displayed when you 
move the cursor.  

18. Move the line cursor in the direction of 225-degree angle.  

You will notice that two blue inferencing lines are displayed. The first one originates 
from the start point of the first inclined line and the other one from the start point of 
the first line of the sketch.  

19. Press the left mouse button at the point where the two inferencing lines intersect.  

You will notice that at this point, the length of the line on the line cursor shows a 
value of 14.14. Also, the delta X and delta Y values in the Line Property Manager 
are displayed as 10 each and the angle is shown as 225-degree.  

20. Move the cursor vertically downward to the start point of the first line.  

You will notice that when you move the cursor close to the start point of the first line, 
a red circle is displayed. Also, the line cursor turns yellow in color and an orange-
colored box is displayed below the line cursor. The length of the line shows a value of 
40.  

21. Press the left mouse button when the red circle is displayed. Right-click to display the 
shortcut menu and choose the Select option to exit the Line tool.  

This completes the sketch of the outer loop. Note that the display of the sketch is 
small. Therefore, you need to modify the drawing display area such that the sketch fits 
the screen. This is done using the Zoom to Fit tool.  

22. Choose the Zoom to Fit  button from the View toolbar to fit the current sketch on 
the screen.  
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The outer loop of the sketch is completed and is shown in Figure 5.  

 

Figure 5 Outer loop of the sketch. 

Drawing Circles  
The circles will be drawn using the Circle tool. You will use the inferencing line originating 
from the start points and endpoints of the inclined lines to specify the center point of the 
circles. As mentioned earlier, the cursor in the sketching environment jumps through a 
distance of 10 mm by default. Therefore, when you move the cursor to define the radius of 
the circle, the minimum value that can be set is 10 mm. But the radius of the circle is 5 mm 
and to specify this value, the cursor needs to jump only through a distance of 5 mm. This is 
the reason you need to modify the document settings so that the cursor jumps through a 
distance of 5 mm.  

1. Choose Tools> Options from the menu bar to invoke the System Options -General 
dialog box. Choose the Document Properties tab.  

2. Select the Grid/Snap option from the area on the left to display the options related to 
linear and angular units. Set the value of the Major grid spacing spinner to 50 and 
choose OK.  

Setting this value to 50 will force the cursor to jump through a distance of 5 mm 
instead of 10 mm. Therefore, when you move the cursor now, the values shown on the 
cursor and the coordinates of the points shown close to the lower right corner of the 
SolidWorks window will be in the increment of 5 mm.  

3. Choose the Circle  button from the sketch toolbar to invoke the Circle tool.  

As the Select  tool was active earlier, the cursor earlier was the arrow cursor. But 

when you invoke the Circle  tool, the arrow cursor will be replaced by the circle 
cursor.  

4. Move the circle cursor close to the lower endpoint of the right inclined line and then 
move it toward the left. Remember that you will not press the left mouse button at this 
moment.  

An inferencing line is displayed generating from the lower endpoint of the right 
inclined line. When you move the cursor toward the left, you will notice that at the 
point where the cursor is vertically in line with the upper endpoint of the right inclined 
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line, another inferencing line is generated from the upper endpoint of the right 
inclined line. This inferencing line will intersect the inferencing line generated from 
the lower endpoint of the inclined line.  

5. Press the left mouse button at the point where the inferencing lines from both the 
endpoints of the inclined lines intersect. Now, move the circle cursor toward the left 
to define a circle.  

6. Press the left mouse button when the radius of the circle displayed above the circle 
cursor shows a value of 5.  

7. Similarly, draw the circle on the left using the inferencing lines generating from the 
endpoints of the left inclined line. The sketch after drawing the two circles inside the 
outer loop is shown in Figure 6.  

8. Right-click in the drawing area and choose Select to exit the Circle tool.  

 

Figure 6 Outer loop of the sketch including circles. 

Drawing the Sketch of the Inner Cavity  

Next, you will draw the sketch of the inner cavity. To draw the sketch of the inner cavity, you 
will start drawing with the lower horizontal line.  

1. Choose the Line  button from the Sketch toolbar. The arrow cursor is replaced by 
the line cursor.  

2. Move the line cursor to a location whose coordinates are 30 mm 25 mm 0 mm.  

3. Press the left mouse button at this point and move the cursor horizontally toward the 
right. Press the left mouse button when the length of the line above the line cursor 
shows a value of 30.  

4. Move the line cursor vertically upward and press the left mouse button when the 
length of the line on the line cursor displays a value of 10.  

5. Move the line cursor horizontally toward the left and press the left mouse button when 
the length of the line on the line cursor displays a value of 10.  

6. Move the line cursor vertically downward and press the left mouse button when the 
length of the line on the line cursor displays a value of 5.  

7. Move the line cursor horizontally toward the left and press the left mouse button when 
the length of the line on the line cursor displays a value of 10.  

8. Move the line cursor vertically upward and press the left mouse button when the 
length of the line on the line cursor displays a value of 5.  
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9. Move the line horizontally toward the left and press the left mouse button when the 
length of the line on the line cursor displays a value of 10.  

10. Move the line cursor vertically downward to the start point of the first line. Press the 
left mouse button when the red circle is displayed. The length of the line at this point 
will show a Value of 10.  

11. Right-click and choose Select from the shortcut menu. This completes the sketch for 
this Tutorial. The final completed sketch is shown in Figure 7.  

 

Figure 7 Completed sketch for the model. 

Saving the Sketch and model  

1. Choose the Save  button from the Standard toolbar to invoke the Save As dialog 
box.  

2. Enter the name of the document as tutorial1.sldprt in the File name edit box and 
choose the Save button. The document will be saved in the specified folder. It is 
recommended that you create a separate folder for SolidWorks files. 
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Figure 8  

3. Select Extrude Boss/Base  on the Features toolbar. The profile changes its 
orientation to pictorial. The Extrude Property Manager appears as shown in Figure 8. 

4. In the Depth text box, type 20 mm as shown in Figure 8. Click OK  to finish 
the extruded base feature. 

5. Choose the Save  button from the Standard toolbar to save the model. 

6. Close the document by choosing File> Close from the menu bar.  
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Module 2b: Basic Sketching II  
In this tutorial, you will draw the basic sketch for the revolved solid model shown in Figure 
1. The sketch for the revolved solid model is shown in Figure 2.  

   
Figure 1 Revolved model for Tutorial 2.             Figure 2 Sketch for the revolved model. 

The steps that will be followed to complete this tutorial are listed below.  

Start a new part document.  

Maximize the part document and then switch to the sketching environment.  

Modify the settings of the snap and grid so that the cursor jumps through a distance of 5 mm 
instead of 10 mm.  

Draw the sketch of the model using the Line tool, refer to Figure 3. 

Save the sketch and then close the document.  

Create a 3-D Model using Revolved Boss/Base Feature. 

Save the model and close the document.  

Starting a New Document  

1. Choose the New  button from the Standard toolbar to invoke the New SolidWorks 
Document dialog box.  

2. The Part  button is chosen by default in the New SolidWorks Document dialog 
box. Choose OK.  

A new SolidWorks part document is opened. But the part document window is not 
maximized in the SolidWorks window.  

3. Choose the Maximize  button available on the upper right corner of the part 
document window to maximize the docun1ent window.  
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As mentioned earlier, when you open a new part document, the part modeling 
environment is active by default. But because you first need to draw the sketch of the 
revolved model, you need to invoke the sketching environment.  

4. Select the Front plane. Choose the Sketch  button from the Standard tool bar.  

A red color origin is displayed and the Sketch Toolbar is displayed. Also, the 
confirmation corner is displayed with the Exit Sketch and the Delete Sketch options 
on the upper right corner of the drawing area. This suggests that the sketching 
environment is activated.  

Modifying the Snap and Grid Settings and the Dimensioning Units  
Before you proceed with drawing the sketch, you need to modify the grid and snap settings so 
that you can make the cursor jump through a distance of 5 mm instead of 10 mm, which is the 
default value. 

1. Choose Tools> Options from the menu bar to invoke the System Options-General 
dialog box. Choose the Document Properties tab.  

2. Select the Grid/Snap option from the area on the left to display the options related to 
linear and angular units. Set the value of the Major grid spacing spinner to 50. Make 
sure the value of the Minor-lines per major spinner is 10. Choose OK to close the 
dialog box.  

The coordinates close to the lower left comer of the SolidWorks window will show an 
increment of 5 mm instead of the default increment of 10 mm when you exit the 
dialog box.  

3. Make sure the Snap to points check box in the Snap area is selected.  

If you selected a unit other than millimeter to measure the length while installing 
SolidWorks, you need to change the unit for the current drawing.  

4. Select the Units option from the area on the left of the Document Properties - 
Grid/Snap dialog box.  

5. Select millimeters from the drop-down list available in the Length units area and 
Degrees from the drop-down list available in the Angular units area. Choose the OK 
button after making the necessary settings.  

Drawing the Sketch  
As evident from Figure 2, the sketch will be drawn using the Line tool. You will start 
drawing the sketch from the lower left corner of the sketch.  

1. Choose the Line  button from the Sketch toolbar. The arrow cursor will be 
replaced by the line cursor.  

2. Move the line cursor to a location whose coordinates are 40 mm 0 mm 0 mm. An 
inferencing line originating from the origin is displayed.  

3. Press the left mouse button down at this point and move the cursor horizontally 
toward the right. Press the left mouse button again when the length of the line above 
the line cursor shows a value of 20.  

4. Move the line cursor vertically upward and press the left mouse button when the 
length of the line on the line cursor displays a value of 20.  
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5. Move the cursor horizontally toward the left and press the left mouse button when the 
length of the line on the line cursor displays a value of 5.  

6. Move the line cursor vertically upward and press the left mouse button when the 
length of the line on the line cursor displays a value of 25.  

7. Move the line cursor horizontally toward the right and press the left mouse button 
when the length of the line on the line cursor displays a value of 20.  

8. Move the line cursor vertically upward and press the left mouse button when the 
length of the line on the line cursor displays a value of 5.  

9. Move the line cursor horizontally toward the left and press the left mouse button when 
the length of the line on the line cursor displays a value of 50.  

10. Move the line cursor vertically downward and press the left mouse button when the 
length of the line on the line cursor displays a value of 5.  

11. Move the line cursor horizontally toward the right and press the left mouse button 
when the length of the line on the line cursor displays a value of 20.  

12. Move the line cursor vertically downward and press the left mouse button when the 
length of the line on the line cursor displays a value of 25.  

13. Move the line cursor horizontally toward the left and press the left mouse button when 
the length of the line on the line cursor displays a value of 5.  

14. Move the line cursor vertically downward to the start point of the first line. Press the 
left mouse button when the red circle is displayed.  

The length of the line at this point will be 20 mm. 

15. Right-click and choose Select from the shortcut menu.  

The sketch is completed but does not fit the screen. Therefore, you need to modify the 
display area such that the sketch fits the screen.  

16. Choose the Zoom to Fit  button from the View toolbar to fit the sketch on the 
screen. The completed sketch for this Tutorial is shown in Figure 3.  

 
Figure 3 Base sketch for the revolved model 
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Saving the Sketch  

1. Choose the Save  button from the Standard toolbar to invoke the Save As dialog 
box.  

2. Enter the name of the document as tutorial2.sldprt in the File name edit box and 
choose the Save button.  

The document will be saved in the selected folder.  

Creating Revolved model 
To create a 3-D Model from the Base sketch shown in Figure 3, we will first draw an axis of 
revolution and then revolve the sketch around the axis. 

1. Choose the Centerline  button from the Sketch toolbar.  

2. Move the line cursor to a location whose coordinates are 35 mm 0 mm 0 mm. An 
inferencing line originating from the origin is displayed.  

3. Press the left mouse button down at this point and move the cursor horizontally 
toward the right. Press the left mouse button again when the length of the line above 
the line cursor shows a value of 30. 

4. Right-click and choose Select from the shortcut menu. 

5. Select Revolved Boss/Base  on the Feature toolbar. The Base-Revolved 
PropertyManager appears as shown in Figure 4. The One-Direction is the default 

type of the revolved feature. The Angle  box is filled with 360 deg automatically. 

 
Figure 4 Base- Revolved PropertyManager.  

6. Clock OK  to accept default setting to create the wheel model shown in Figure 1. 

7. Save  and close the file. 
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An alternate approach to draw the Base sketch shown in Figure 2. 
In SolidWorks we may complete the sketch following different approaches. The same sketch 
shown in Figure 2 will be drawn using another approach.   

1. Choose the New  button from the Standard toolbar to invoke the New 
SolidWorks Document dialog box.  

2. The Part  button is chosen by default in the New SolidWorks Document dialog 
box. Choose OK.  

3. Select the Front plane. Choose the Sketch  button from the Standard tool bar.  

A red color origin is displayed and the Sketch Toolbar is displayed. Also, the 
confirmation corner is displayed with the Exit Sketch and the Delete Sketch options 
on the upper right corner of the drawing area. This suggests that the sketching 
environment is activated. 

4. Click Centerline  on the Sketch toolbar and draw a vertical line approximately 
60 mm in length starting at the origin as shown in Figure 5. 

 

Figure  5 Centerline for the Base sketch. 
5. Click Line  and complete one side of the sketch starting at 

the origin as shown in Figure 6. All line segments should be 
Horizontal or Vertical.  

Do not worry about the sizes of the lines. We will adjust them 
later.  

6. Select centerline and all other lines by making a window around 

the sketch as shown in Figure 7.  Figure 6 Right half of the sketch. 

 

7. Click Sketch Mirror   on the Sketch toolbar. Sketch profile 
is complete and is shown in Figure 8.  

 

 

 Figure 7 All line segments selected. 
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Figure 8 Sketch profile without sizes. 

 

Now we will adjust the sizes of the sketch. 

8. Select Dimension  on the Sketch Relation toolbar. 

9. Click the bottom line. Move the mouse below the bottom line. Click to place the 
dimension.  

10. Change the dimension to 20 mm. 

11. Click the lower right line. Move the mouse 
to the right. Click to place the dimension. 

12. Change the dimension to 20 mm. (Figure 9).  

13. Click the middle vertical lines on the right of 
the center line then click the similar vertical 
line on the left of the centerline. Move the 

mouse upward. Click to place the 
dimension. 

Figure 9 Editing dimension. 

14. Change the dimension to 10 mm. 

15. Similarly place the remaining dimensions. The sketch 
should look like as shown in Figure 10.  

 

16. Choose the 
Centerline  
button from the 
Sketch toolbar and 
draw a horizontal 
line passing through 

the origin and 
extending in both 
sides of the sketch as 
shown in Figure 11.  

Figure 10 Final sketch with sizes. 

 

Figure 11 Base sketch with Axis of revolution. 
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17. Select Revolved Boss/Base  on the Feature toolbar. The Base-Revolved 
PropertyManager appears as shown in Figure 12. The One-Direction is the default 

type of the revolved feature. The Angle  box is filled with 360 deg automatically. 

 
Figure 12 Base- Revolved PropertyManager. 

18. Clock OK  to accept default setting to create the wheel model shown in Figure 1. 

19. Save  and close the file. 
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Module 3: Extruded Feature; V-Block 
In order to demonstrate how to create extruded features step by step, a V-Block model is used 
in this tutorial. Its geometry and dimensions are given in Figure. 1. 

 
Figure 1.  V-Block 

 Modeling Procedure 

Before a model is created, a strategic plan for modeling should be done. The following points 
should be considered: 

• Which view of the part best conveys its shape? 
The base feature is usually the most prominent feature in that view. 

• What is the most important feature of your part? 
Create these features early in the modeling process so you can use them for creating 
subsequent features. 

• Can the origin and coordinate planes be used to modeling advantage? 

After the above considerations, the V-Block can be created from the following steps as 
shown in Figure2. 

1) Create a 100mm x 85mm x 70mm block using the Extrude Boss/Base. 

2) Cut a 30mm x 20mm x 85mm Rectangular Slot using Extrude Cut. 

3) Cut a V-slot using Extrude Cut. 

4) Cut a Trapezoid slot using Extrude Cut. 

 
Figure 2 V-Block Modeling steps. 
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Start Solid Works and Set up Properties 
1) Start Solid Works. 

2) Click New  on the Standard toolbar, or select File, New on the menu bar. 

3) Select Part  from the Tutorial tab in the dialog box and then click OK. 

4) Click File, Properties on menu bar. 

5) Fill in the necessary properties in the dialog box, and click OK to accept the 
properties and close the dialog box. 

6)     Select Tools, Options on the menu bar to open the Options dialog box. 

7) Select the Document Properties tab, and click Unit in the properties tree text box. 

8) Select Millimeter and set the decimal places to 2 as shown in Figure 3. The 
available units are Millimeters, Centimeters, Meters, Inches, Feet, Feet, Inches, etc. 

 
Figure 3 Units selection 

9) Click Material Properties in the properties tree box. Change the density to 0.0078 
g/mm3

 as shown in Figure- 4. 
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Figure 4 Material properties 

10) Click Grid/Snap in the properties tree box. Check the Display grid check box in the 
grid frame to display the grid in the sketch environment as shown in Figure 5. 

 
Figure 5 Grid/Snap 
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11) Click OK to accept the changed properties and close the dialog box. 

Create Extruded Base Feature 

1) Click Sketch  on the Sketch toolbar. 

2) Bring cursor closer to Front plane, when highlighted, Click on it to open a new 
sketch on Front Plane. 

3) Select Rectangle  on the Sketch 
Tools toolbar. 

4) Click the origin as one corner of the 
rectangle. 

5) Move the mouse up and right, and 
click to locate the other corner of the 
rectangle. A rectangle is created. The 
left vertical line and the bottom 
horizontal line change the color to 
black (black is the default color. It 
could be a different color) because 
the left lower corner is coincident 
with the origin, and a coincident relation is applied between the origin and the lower 
left corner automatically as shown in Figure 6. The top horizontal and right vertical 
lines are blue (default color) because they need some dimensions to define them. 

Figure 6 Partially constrained Rectangle 

6) Select Dimension  on the Sketch 
Relation toolbar. 

7)    Click the bottom line. Move the mouse 
below the bottom line. Click to place the 
dimension. 

8)     Change the dimension to 100 mm. 

9)     Click the right line. Move the mouse to the 
right. Click to place the dimension. 

10)    Change the dimension to 70 mm. The 
sketch is fully constrained, and turns to 
black (default color) as shown in Figure 7. 

 

11) Select Extruded Boss/Base  on the 
Features toolbar. The profile changes its orientation to isometric. The 
PropertyManager appears. 

Figure 7 Base sketch of the Block 

12) Move the mouse to the left side of the sketch, and click to accept the extrude 
direction. 

13) In the Depth text box, type 85 mm as shown in Figure 7. Click OK  to 
finish the extruded base feature. 
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Figure 7 Extruded Base Feature  

Cut Rectangular Slot 

1) Select the front surface of the base feature as shown 
in Figure 8. 

2) Select Sketch  on the Sketch toolbar to open a 
sketch on the front surface. 

3) Select Normal To  on the Standard Views toolbar 
to make the sketch parallel to the screen. (If the 
Standard Views toolbar is not displayed, select View, 
Toolbar, Standard Views on the 
menu bar to open the Standard Views 
toolbar.) 

Figure 8 Sketch Plane for Rectangular Slot 

4) Select Wireframe  on the Views toolbar to 
change the model display to wireframe from the 
shaded mode. 

5) Select Line  on the Sketch Tools toolbar to 
draw 3 lines as shown in Figure 9. 

6) Select Dimension   on the Sketch Relation 
toolbar. 

  Figure 9 Rectangular Cut Sketch 

7) Dimension the sketch as shown in Figure 10. The sketch is fully constrained and 
turns to black. if not, apply coincident constraints to the endpoints of the vertical 
lines with the top edge of the part.            

  

8) Select Extruded Cut  on the Feature toolbar. 
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9) Select Through All from the end condition 
drop down list box in the Cut-Extrude 
PropertyManager as shown in Figure 11. 

10) Click OK  to finish the cut. 

11) Click Shaded   on the View toolbar to 
change the model to Shaded mode to check 
the cut. 

                  

 

Figure 10 Rectangular Slot Dimensions 

Figure 11 Rectangular Slot Cut 

Cut V-Slot 

1) Select the right surface of the part as the V-Slot sketch plane as shown in Figure 12. 

2)     Select Sketch  on the Sketch toolbar to 
open a new sketch. 

3) Select Normal To   on the Standard Views 
toolbar to make the sketch parallel to the 
screen. 

4) Select Line   on the Sketch Tools toolbar. 

5) Draw five lines to form the geometric V-slot 
shape as shown in Figure 13. 

 

Figure 12 Sketch plane for V-Slot Cut 
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Figure 14 Centerline for V-Slot Sketch Figure 13 V-Slot Sketch 

6)    Select Centerline  on the Sketch Tools toolbar. 

7)    Draw a vertical centerline within the V-slot sketch as shown in Figure 14.  

8) Select Add Relation  on the Sketch Relation toolbar. 

9) Select two angled lines and the centerline. 

10) Select Symmetric   in the Add Relation PropertyManager as in Figure 15 to 
make two angle lines symmetric about the centerline. 

11) Select two vertical lines and the centerline. 

12) Select Symmetric   in the Add Relation dialog box as shown in Figure 16 to 
make two vertical lines symmetric about the centerline. 

    
 

Figure 15 Symmetric Constraints for Two 
Angled Lines 

Figure 16 Symmetric Constraints 
for Two Vertical Lines 
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13) Select two vertical edge lines on the face  and the centerline. 

14) Select Symmetric   in the Add Relation dialog box as shown in Figure 17 to 
make centerline at the center of face. 

 

 
Figure 17 Symmetric Constraints for the centerline at the center of the face 

 

15) Click on the OK  button to close the Add Relation PropertyManager. 
    

16) Select Dimension on the Sketch Relation toolbar. 

 
 Figure 18 V-Slot dimensions 
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17) Dimension the sketch as shown in Figure 18. The sketch is fully constrained. If not, 
apply coincident constraints to the two endpoints of the vertical lines with the top 
edge of the part. You may also drag the end point of the angled line to make it 
coincident with the top horizontal edge of the part. 

18) Select Extruded Cut  on the Features toolbar 

19) Select Through All from the end condition drop down list box in the Cut-Extrude 
PropertyManger. 

20) Uncheck Direction 2 as shown in Figure 19. 

 
Figure 19 V-Slot Cut. 

21) Click OK  to finish the cut. 

21) Click Rotate View  on the View toolbar, and drag the mouse to rotate the 
model. Right click and select Rotate View from the context menu to end the rotate 
view command. 

22) Select Isometric  on the Standard Views 
toolbar to set the part orientation to Isometric. 

 

Cut a Trapezoid Slot 
1)    Select the same surface as the V-Slot cut as 

the sketch plane for the trapezoid cut as shown 
in Figure 20. 

2)    Select Sketch  on the Sketch toolbar to 
open a new sketch. 

Figure 20 Sketch plane for    
Trapezoid Slot cut 
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3)    Select Normal To   on the Standard 
Views toolbar to make the sketch parallel to 
the screen. 

4)    Select Line  from the Sketch Tools 
toolbar. 

5)    Draw three lines to form the trapezoid slot 
sketch as shown in Figure 21. 

6) Select Centerline  on the Sketch Tools 

toolbar. 

7) Draw a vertical centerline starting from 
the mid-point of the lowest horizontal edge as the symmetric axis for the trapezoid 
slot.  

Figure 21 Trapezoid Slot Sketch 

8) Select Add Relation  on the Sketch Relation toolbar. 

9) Select the two angled lines and the centerline. Select Symmetric  in the 
PropertyManager as shown in Figure 22. 

10) Click OK to close the PropertyManager. 

 

 Figure22 Symmetric constraint for Angled lines 
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11) Select Dimension  on the Sketch Relation 
toolbar. 

12) Dimension the sketch as shown in Figure 23. 

13) Select Extruded Cut  on the Features 
toolbar. 

14) Select Through All from the end condition 
drop down list box in the Cut-Extrude 
PropertyManger. 

15) Check Flip side to cut to change the cut 
direction toward inside. 

Figure 23 Trapezoid Slot Dimensions 16) Uncheck Direction 2 as shown in 
Figure 24. 

 

 
Figure 24 Trapezoid Slot Cut 

 

 

17) Click OK  to finish the cut. The 
final part is shown as in Figure 25. 

 

 

 

 

 

Figure 25 V-Block Model 
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Change Feature Names and Check Model Mass Properties 
Once features are created, they are listed in the FeatureManager Design Tree as shown in 
Figure 25 with default names. You may have slightly different default names. Those names 
could remain as they are, but, it is recommended to change the default names to make the 
features recognized easily: 

 
Figure 26 FeatureManager Design Tree  

 

To change the default names: 

1) Click Extrude1 twice (not double click) in the FeatureManager Design Tree. 

2) Type Block as the new name. 

3) Click Cut-Extrude1 twice, and change it to Rectangular-Slot. 

4) Click Cut-Extrude2 twice, and change it to V-Slot. 

5) Click Cut-Extrude3 twice, and change it to Trapezoid-Slot. 

The new FeatureManger Design Tree is as shown in Figure 27. 

 
 

Figure 27 Updated FeatureManager 
Design Tree 
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To check the model mass properties: 
1) Select Tools, Mass Properties on the menu bar. 

2) The Mass Properties dialog box appears. The Measurement Options dialog box 
appears, and the mass properties are calculated automatically as in Figure 28.   
Note: in the dialog box, the mass density is displayed as 0.01 gram per cubic 
millimeter because the decimal places format is set as 2. It does not influence the 
mass properties. 

 

Figure 28 Mass Properties  
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3) To display the correct value of the mass density, select the Options button. The 
Mass/Section Property Options dialog box appears as shown in Figure 29. 
Change the Decimal Places to 4, the mass density is displayed as 0.0078 g/mm3 
in the Density text box as shown in Figure 30. 

 

     
 

 

4)  

Figure 30 Mass Properties Figure 29 Mass/Section Property 
Options 

4) Click the OK button to close the Options dialog box. 

5) Click on the Print button to print the mass properties, or click Copy to copy them 
into the clipboard. Then they can be copied to other programs. 

6) Click Close to close the Mass Properties dialog box. 

7) Choose the Save  button from the Standard toolbar to save the model.  
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Module 4: To Construct Housing Body and Add Multiple 
Features 

1. Start the Program  Desktop Symbol OR Start Menu 
 

2. Select ‘New Document’  from the Welcome window OR Select 
‘New’ button OR Select File-new OR Ctrl+N. 

 

3. Select ‘Tutorial Tab’ and then ‘Part’  
 

4. Select ‘Top’ (plane) from the ‘Feature Manager Design tree’. 
 
5. Select ‘Normal to’  from the Standard Views Toolbar. 

 
6. Select ‘Sketch’ button  OR Insert – Sketch from the dropdown menu 

bar at the top of your screen.  
 

7. Select the ‘Rectangle’ button  .  Notice that the cursor changes to a 
pencil symbol with a rectangle. 

 
8. Place the Rectangle pencil at the lower left of the red origin and click 

the left button of the mouse ONCE (left click). 
 

9. Drag the mouse to the top right of the red origin.  (Notice the x-y 
coordinates changing at the bottom of the screen)  Left click once.   
The size of the rectangle is not important at this stage.  The rectangle is 
now green and the symbol is disconnected from the sketch. 
   

 
 

Figure 1 
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N.B. Look at the bottom right of the screen.  As the cursor moves, the x & y 
coordinates change to indicate the location, ‘z’ is zero since this is a 2D sketch.  
The screen also indicates that we are ‘Editing Sketch 1’ and that the sketch is 
‘Under Defined’. 

 

10. Choose ‘Select’  from the Sketch Toolbar.  The sketched rectangle is 
now blue and the Rectangle Command is complete.                                                                  

 

 
Figure 2 

 
11. Choose ‘Smart Dimension’  from the Sketch Toolbar.  The cursor 

now indicates a dimension symbol.  

12. Dimension the sketch as shown in the Figure 11. 

 
Figure 3 

Notice that the sketch is now completely black, that it is 76mm square and that it 
is centred on the origin.  Note also that the box at the bottom right of the screen 
indicates that the sketch is now fully defined.  
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13. Choose the select  button to end the dimension command. 

 
The sketch can now be transformed into a 3D solid object.  Notice the Features 
Toolbar is now giving access to the Extruded Boss/Base Tool  . 

 
14. Choose the ‘Extruded Boss/Base’ button . 
 

The Extrude manager opens and the sketch is displayed on screen as an 
isometric view.  A default distance of 10mm is added to the model in the 
direction of the arrow shown. 
 

 
 

Figure 4 
 

15. Leave the End Condition as ‘Blind’.  Use the up arrow at the side of the 
depth box  (d1) to increase the value to 20mm.  Notice that the 
model increases by 10mm in the direction of the arrow on screen.  
Highlight this 20mm value and use the backspace key on the keyboard 
to remove.   
Replace the 20mm with a new value of 38mm and press the enter key.  
Once again the model changes to the new value.  Select the green tick 

 to accept the model with this distance. 
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Figure 5 

 
Notice that the Feature Manager Design tree now shows Extrude 1 with a ‘+’ 
box to its left.  Place the cursor on the ‘+’ box and left click to open it.  Notice 
that Sketch 1 is the base of the extruded model. 
 

 
Figure 6 

 
16. Right click on Sketch 1 and choose Edit sketch.  
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Figure 7 

 

17. Choose ‘Normal to’  from the Standard Views Menu.  
 

 
Figure 3 

 
The now familiar returns to the screen and may be edited. 
 

18. Choose ‘Sketch fillet’  from the Sketch tools Toolbar. 
 

The sketch fillet property manager opens with a default radius of 10mm. 
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Figure 4 

 
19. Change this radius to 5mm and select each corner of the sketch. 

 
Notice that each corner is highlighted by a red dot as it is identified.  Also note 
that the fillet dimension is added to the sketch on the first fillet only.  Ensure 
that the ‘Keep constrained corners’ box is checked.  Select the green tick  
(OK). 
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Figure 5 

 
The Feature Manager Design tree now shows a rebuild required symbol to the 
left of Extrude 1. 

 
20. Left click the ‘Rebuild’ button  and select ‘Isometric’  from the 

Standard Views menu. 
 

 
Figure 6 

 
We now need to make the base of the model hollow.  To view the base we must 
rotate the view to see the flat bottom. 
 

21. Choose the ‘Rotate view’ button .  The cursor now appears like two 
semi circular arrows following each other.  Press the left button of the 
mouse and hold it down.  Still holding the left button down rotate the 
model so that the bottom surface is visible.  Release the mouse button 
when you are finished rotating the model and press the rotate button 
once more to end the command. 
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Figure 7 

 

 
Figure 8 

22. Select the bottom face of the model by placing the cursor over the face.  
Notice the flag appearing as the edges of the face are highlighted in 
red.  Left click to select the face.  The selected face is now green 
(active). 
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Figure 9 

 
23. Choose ‘Shell’  from the Feature menu.  The shell property manager 

opens.  Face<1> is already shown in the Faces to remove box and a 
default value of 10mm is indicated in the thickness window.  This 
value is satisfactory for our model so there is no need to change it.  
Press the green tick for OK  . 

 

 
Figure 10 
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Notice that the base is now shelled or hollowed out with a thickness of 10mm.  
The Feature Manager Design tree indicates Shell 1. 
 

 
Figure 11 

24. From the File menu select ‘Save as’.  In the save as dialog box save the 
model as (give a file name here). 

 
Figure 12 
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Notice that this new name appears at the top of the screen and at the top of the 
Feature Manager design tree. 
 

25. Go to Isometric view  and then select the top surface of the model 
and then choose ‘Normal to’  from the View menu. 

 

 
Figure 13 

 
26. Open a new sketch on this surface.  Select ‘Sketch’ . 

 
27. Choose ‘Circle’  from the Sketch tools toolbar. 

 
Notice that the pencil symbol is now accompanied by a circle symbol. 
 

 
Figure 14 
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28. Place the pencil symbol on the model origin.   
 

Notice that it changes colour (it becomes yellow and that the circle symbol is 
replaced by an orange square). 
 
Left click once again to place the circle centre at the model origin.  The 
circle property manager opens.  Drag the mouse from the origin to 
draw the circle.   
 
Notice that the circle centre is fixed at the origin and that the circumference is 
attached to the mouse.   
 
The circle radius is shown beside the symbol.  For this model the circle 
radius needs to be about 32mm.  When the circle radius is about 32mm 
left click once, to place the circle and end the command.   
 

 
Figure 15 

 
29. Right click once.   

 
By right clicking we can open a shortcut menu to some commands, including 
the dimension command.   
 
Choose Dimension from he shortcut menu by left clicking on the word 
‘Dimension’ 
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Figure 16 

 
Notice that the circle command is now complete and the circle is blue in 
colour, fixed to the origin but still under defined.  To fully define the circle we 
must add a dimension. 
 
Select the circle at any point on its circumference and place the 
dimension at any convenient location.  In the modify box delete the 
value and enter 64mm.   
 
The Ø64 is added to the model and the circle re-sizes to the correct dimension.  
The circle sketch is now black and fully defined.   
 

 
Figure 17 
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Right click once again and choose select to end the dimension 
command. 
 
Sketch 2 is added to the Feature Manager Design tree. 
 

30. Select ‘Extruded Boss/Base’  from the Features Toolbar.  The 
extrude feature property manager opens with a value of 10mm.  
Choose ‘Isometric’  (from the Standard views menu) to see the 
model more clearly.  The height of the boss should be 38mm, and we 
wish to merge the result.  Enter the value 38 into the depth box and 
check the merge result box if needed.  

 

 
Figure 18 

 
Notice that the circle sketch is extruded from the top surface of the base for a 
distance of 38mm in the direction of the arrow. 
 

 
Figure 19 
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Left click the green  tick to accept the extrusion. 
 
Notice that Extrusion 2 is now added to the design tree.  Open extrusion 2 as 
before and note that its base is sketch 2 (the circle). 
 

31. Place the cursor on the top surface of the extruded boss.  Notice that 
the surface is outlined in red and that a flag symbol appears with the 
cursor arrow.  Left click to accept this surface; it turns green to indicate 
that it now active.  Open a third sketch on this surface. 

 
32. Choose ‘Circle’  as before.  Place the pencil symbol anywhere on the 

green surface BUT NOT ON THE ORIGIN.  Draw a circle of any size. 
 

 
Figure 20 

 
We now need to define this sketched circle.   

 
33. Right click and choose ‘Dimension’.  Dimension the circle to be 

Ø48mm. 
 

To fully define sketch 3 we must now fix its centre. We can do this by using 
geometry. 
 

34. From the ‘Sketch relations’ toolbar choose ‘Add Relation’ .  The Add 
Relation Property Manager opens.   
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Figure 21 

 
The selected entities box is pink indicating that it is active.  Place the 
cursor on the blue circle and left click to select.  The circle is added to 
the pink box as Arc 1 and the existing relation, its diameter, is listed in 
the white box. 

 
Place the cursor on the top edge of the Boss.  It is now red; left click to 
select this edge.  The edge of the boss is added to the selected entities 
box (the pink box) as edge <1>.    
 
The geometry relations that are now possible between these two features are 
now listed under ‘Add relations’.  We wish to make these two features 
concentric, i.e. to have the same centre. 

 
Figure 22 
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Choose ‘Concentric’  by left clicking the mouse.  Concentric 0 is 
added to the existing relations box and the green circle (sketch 3) 
moves so that its centre coincides with the boss centre.  Choose the 
green tick  to end the command. 
 

 
Figure 23 

 
35. We now wish to cut a counterbore hole in the top of the Boss.   

 
Figure 24 

 
From the Features toolbar, select ‘Extruded Cut’ .  The Extruded cut 
Property Manager opens.  In the depth window change the value to 
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12mm.  Check that the end condition window shows ‘Blind’.  Select OK 
to cut the counterbore hole in the top pf the Boss. 
 

 
Figure 25 

 

 
Figure 26 

 
36. Save!!!  (Regularly) 
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We now wish to cut a hole from the bottom of the counterbore all through the 
boss and into the shelled base.  

 
37. Select the bottom of the counterbore hole.  Open a new sketch on this 

surface and draw a Ø30mm circle concentric with the boss. 
 

38. With sketch 4 active choose ‘Extruded Cut’ .  This time select the 
small down arrow at the right side of the ‘End Condition’ window.  
The option to choose is ‘Through All’. 

 

 
Figure 27 

 
Notice that we do not need to give a depth when using this option.  
 
Select OK  to cut the hole.   
 
Extrude-Cut 2 is added to the design tree.  Use the rotate View button to look 
at the model from any direction.  Return to the isometric view when you are 
satisfied that the hole is cut through. 

 

 4-20



 
Figure 28 

 
39. We need to add a fillet to the bottom of the boss and the top surface of the 

square base.  We can achieve this with the fillet command from the Feature 
Toolbar. 

 

 
Figure 29 

Select the top surface of the square base.  It is now outlined and shaded 
green.  Choose ‘Fillet’  from the feature toolbar.  Face <1> is already 
selected and shown in the ‘Items to fillet’ box (the pink box).  Change 
the fillet radius to 3mm. 
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Figure 30 

 

 
Figure 31 

 
Notice the preview of the fillet appearing on the model, it will be shown in 
yellow. 
 
Choose OK  to accept the fillet. 
 

40. Save your work !!!! 
 
At this stage of the model construction we may add fillets to the hidden edges 
inside the square base. 
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41. From the view toolbar select ‘Hidden lines visible’.  The sharp edges 

that need to be filleted can be seen and are shown as broken lines.   
 

 
Figure 32 

 

 
Figure 33 

 
We need to select each of them one by one and to do this we will use the 
control key on the keyboard.  
 

42. Press the control key on the keyboard and HOLD IT DOWN.  Select 
the four vertical edges.  They will become red when your cursor is on 
them.  As you select each one it will turn green.   
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Still holding the control key down, select the four horizontal edges in 
the same way.  When all eight edges have been selected, release the 
control key. 

 

 
Figure 34 

 

 
Figure 35 

 
43. Choose the ‘Fillet’  button from the Feature toolbar.  Since the 3mm 

setting from the last command should still be active in the Fillet 
Property Manager, your model should show a yellow preview of the 
internal fillets.   
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Figure 36 

 
44. Choose OK  to accept the fillets. 

 
45. Sketch ‘Shaded’  from the View toolbar and rotate the model to see 

your internal fillets.  Use the ‘Isometric’ button  to return to the 
standard isometric view. 

 

 
Figure 37 
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Figure 38 

 

 
Figure 39 

 
Save your work! 
 

We need to add boss to the right face of the square base.  
 

46. Select the right face of the square base, look for the flag and notice the 
selected surface colour change as before. 

 
47. Choose ‘Normal to’  and open a sketch  on this surface. 
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48. Select ‘Circle’  and draw a circle towards the right side of the 
surface. 

 

 
Figure 40 

 
49. Right click and choose ‘Dimension’ from the short-cut menu.  

Dimension the circle to have a Ø24mm. 
 

50. Continue with the dimension tool to position the circle centre at 24mm 
from the right edge and 24mm from the top surface of the square base.  
Sketch 5 is now fully defined. 

 

 
Figure 41 
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Figure 42 

 
51. Use the ‘Extrude Boss/Base’  tool to extrude the circle for a distance 

of 10mm.  Use the isometric button to help you see what you are doing. 
 

 
Figure 43 

 
52. Add a 3mm fillet to the new boss feature.  Select the circle at the base of 

the new boss and then choose the ‘Fillet’ button  from the features 
toolbar.  Enter a value of 3mm into the radius window and then OK. 
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Figure 44 

 

 
Figure 45 

 
53. The last requirement for this model is a hole through this boss.  Select 

the flat outer surface of the boss and open a ‘Sketch’ .  Choose 
‘Circle’  and draw a circle on this surface.  Right click and dimension 
the circle to have a Ø16mm. 

 
54. Now add a ‘Concentric relation’ to place the circle.  Choose ‘Add 

relation’ , select the circle and then select the edge of the boss.  
Choose ‘concentric’ from the Add relations Property Manager. 
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Figure 46 

 
55. Use ‘Extruded Cut’  to make the hole.  Be sure to keep the end 

condition as ‘Blind’.  Change the depth to 20mm and click OK . 
 

 
Figure 47 

 
Rotate the model to see inside the base.   
 

56. To change the colour of the model, first select the file name at the top of 
the feature manager design tree.   
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It is now highlighted, select ‘Edit Colour’   from the Standard 
toolbar.  You may now choose any colour you like! Try one of them or 
define your own colour.  When you have selected a colour pick the 
‘Apply’ button and then OK.  Your model changes to your chosen 
colour! 

 

 
Figure 48 

 

 
Figure 49 

 
Your model is complete so ………. SAVE YOUR WORK ! 
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Module 5: To create the 2-D Drawing from a 3-D Model 
 

1. Start the program. 
 

2. Select ‘Open Document’ . 
 

3. Choose the Housing Exercise from the location where you have it 
saved. 

 
i. Note the ‘preview’ window, this window permits you to look 

at the file before opening it. 
ii. The ‘Files of type’ window.  The down arrow allows you to 

display only your selected type of file from the drop down 
menu.  In this case the type of file is a ‘part file’ and has the 
file extension (*.prt) or (*.sldprt). 

 
Select ‘open’. 
 

4. With the Housing file open select ‘New’ and choose ‘Draw’  from 
the tutorial window.  See Figure 1. 

 
Notice that a preview of a standard drawing border is shown. 
 
Select ‘open’. 
 

 
Figure 1 

 
5. In the white drawing area ‘Right click’ once to open a short-cut 

window.  Select ‘Properties’ to open the ‘Sheet Setup’ box.  See Figure 
2.  In the sheet set-up box use the down arrow at the right side of the 
paper size box to choose the paper size, in this case, A3-Landscape. 
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In the Sheet Format window select A3-Landscape to match the paper 
size.  Leave the scale at 1:2 for the time being.  Ensure that the type of 
projection selected is ‘Third angle’.  Click OK when these selections 
are made.  See Figure 3. 
 

 
Figure 2 

 

 
Figure 3 

 
The default border is now replaced by your selected border. 
 

6. Use the ‘Zoom to Area’  button from the View Toolbar to examine 
the border contents.  Left click the ‘Zoom to Area’ button and draw a 
window around the ‘Title block’ of the border.  To do this, place the 
cursor symbol at the upper left corner of the Title Block, left click and 
HOLD THE LEFT BUTTON DOWN.  Drag the cursor symbol to the 
lower right corner of the Title Block to draw a green window.  Release 
the mouse button and the contents of the window are scaled to fill the 
screen.  See Figure 4.  Select the ‘Zoom to Area’ button once again to 
end the command. 
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Figure 4 

 
Notice that there are some new Toolbars available at the left side of the screen.  
The one at the top should be the ‘Annotations Toolbar’ and the one under it 
should be the ‘Drawing Toolbar’. 
 

7. From the ‘Annotations Toolbar’ choose ‘Note’. 
 

The Note Property Manager opens and a NOTE box is fixed to the cursor. 
 

 
Figure 5 

 
 
Place the Note box in the Title Area of the Title Block.  See Figure 5. 
 
This note box is now active, but the font size is too big.   
 
In the Note Property Manager de-select ‘Use document’s font’.   
 
By de-selecting this function we now have access to the font button.   
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Choose the font button to open the choose font box.  In the ‘Font’, area 
scroll to find ‘Book Antigua’ and select.  In the Height area, select 
‘Points’ and scroll to select a value of 20.  See Figure 6. 
  

 
Figure 6 

 
Note that while the units box is disabled (greyed out) its value still changes.  
Note also that a font sample is shown on screen. 
 
When these changes are made, select OK. 
 

8. Left click in the Note box and type the drawing title ‘Housing Body’.  
When complete, select the green tick in the Note Property Manager. 

 
9. Add ‘K.F.U.P.M. Mech. Eng. Dept.’ in the empty box above the title.  

Adjust the font size to make this new note fit the space available. 
 

10. In the material box add ‘Cast Iron’. 
 

11. Under the Name Box add your ‘family name’.  Under signature add 
‘your ID Number’.  Under Date add the ‘date the drawing was made’.  
See Figure 7. 
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Figure 7 

 
Note that a Dwg No (Drawing Number) is already in place.  This drawing 
number will be the same as your file name. 
 

12. From ‘File’ select ‘save as’ and save your work.  See Figure 8. 
 

Note that the file type extension is now (*.drw) or (*.slddrw).  
 
 Use the ‘rebuild’ button  to update your drawing sheet. 
 

 
Figure 8 

 
13. To modify the drawing number we must right click in the drawing 

area and select ‘Edit Sheet Format’ we can now select the drawing 
number.  See Figure 9.  Right click on the drawing name and select 
‘Edit text’.  Choose ‘Font’ from the Note Property Manager and change 
the font to match the other notes that you have just added to the sheet.  
Choose OK to update your drawing sheet.  See Figure 10. 

 

 5-5



 
Figure 9 

 
14. Right click in the drawing area and select ‘Edit sheet’ once again to exit 

the command. 
 

 
Figure 10 

 
Save your work! 

 
15. The basic preparation is complete so now choose ‘Zoom to fit’ .  (At 

this stage the drawing border may be saved as standard A3-Landscape 
template for further use.)   

 
16. We are now ready to insert the drawing.   

 
Select ‘Standard 3 View’ from the ‘Drawing Toolbar’.  See Figure 11. 
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Figure 11 

 
  The ‘Standard View Property Manager’ opens and the cursor is 

accompanied by an isometric view symbol.  The Standard View Property Manager 
lists four different methods you may use to select a model.  In this exercise the 
model file is open, so we can use either choice 2 or 3.  See Figure 12.   

 

 
Figure 12 

 
From the window drop down menu, select the Housing Model file.  
See Figure 13. 
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Figure 13 

 
The model window opens with the cursor still indicating the draw symbol.   
 
Left click anywhere in the graphics area of the screen.   
 
The drawing border becomes visible again.  We now have to decide if we wish 

to show ‘tangent edges’.   
 

 
Figure 14 

 
For most circumstances it is best to remove these tangent edges when 

working with orthographic drawings, so ensure that the ‘removed’ option 
is selected and then select OK.  See Figure 14. 

 
The Three standard orthographic views of the model are inserted into the 
drawing sheet border.  These views are added to the Feature Manager Design 
Tree.  There will be one view highlighted at all times, and we can work on the 
highlighted view only.  See Figure 15.   
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Figure 15 

 
To highlight other views, simply move the cursor close to the view you 
wish to work with and left click. 
 

17. Place the cursor close to the PLAN (the top view).   
 
Notice that the view is framed in a grey box and that the cursor now has a 
view edit symbol next to it.   
 

   
Figure 16 

  
 With the cursor inside this grey border left click once.  The Projected 
View Property Manager opens and the view is now surrounded by a 
green window.  See Figure 16.  Place the cursor on the lower horizontal 
edge of this window.  Note the arrow symbol that appears.  When the 
arrows are visible press and hold down the left button of the mouse.  
We can now move this view ‘up’ or ‘down’ on the screen.  Move the 
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PLAN View closer to the ELEVATION (front view).  Note that while we 
can move this view vertically, we are unable to move it horizontally!  See 
Figure 17.  
 

 
Figure 17 

 
18. Place the cursor close to the RIGHT END ELEVATION (right end 

view) to highlight it.  Left click once to activate the window.  This time 
place the cursor on the left vertical edge of the green window.  Press 
and hold the left mouse button as before and move the view.  Notice 
that this view can only be moved from ‘left to right’.  Place the view at 
a suitable location to the right of the ELEVATION.   

 
19. Now bring the cursor close to the ELEVATION (the front view) and 

activate its window.  Place the cursor on any part of the green window, 
click and hold the left button once more.  See Figure 18.  Now, when 
we move the ELEVATION all three views will move together.  Note 
also that we can move the orthographic group of views to any location 
on the screen.  Re-position the views so that they do not overlap the 
drawing border or the title block area.  Left click anywhere in the 
drawing area to end the command. 
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Figure 18 

 
20. We need to show the hidden edges in these views.  Place the cursor 

close to the PLAN and left click once.  From the view Toolbar choose 
‘Hidden Lines Visible’.  The hidden edges of the PLAN VIEW are 
now switched on. 

 
21. Place the cursor close to the ELEVATION to activate it.  Hold down 

the control button and select the RIGHT END ELEVATION.  Now 
switch on the hidden edges for these two views as before. 

 
SAVE YOUR WORK! 

 
Notice that where we can see circles (in the PLAN and the RIGHT END 
ELEVATION) the centre lies have been added automatically.  However we 
MUST SHOW CENTRE LINES for all cylindrical features of the 
orthographic views. 

 
22. To add centre lines to the cylindrical features of the drawing, first 

select ‘Centrelines’ from the ‘Annotations Toolbar’.  See Figure 19.   
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Figure 19 

 

 
Figure 20 

 
Notice the message on the Centreline Property Manager.  This message 
indicates how we may ad centrelines to the drawing views. 
 
Place the cursor on the surface of the large boss in the ELEVATION.  
See Figure 20.  
 
Notice the surface flag as the cylindrical surface is identified. 
 
Left click once to add the centreline.  This centreline should extend to 
the bottom of the hidden hole.  To lengthen the centreline place the 
cursor on the centreline, note the colour change and the centreline 
symbol.   Left click to select the centreline.  The centreline is now 
active, is green and has two ‘handles’ one at each end.   
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Select the lower handle by pressing and holding the left button of 
the mouse.  Still holding the left button, drag the centreline down to 
the bottom of the hole and release.  See Figure 21. 
 

 
Figure 21 

  
The centrelines of the circles (representing the bosses and bores) in the 
PLAN and END ELEVATION may be dragged in the same way. 
 

23. We can place centrelines by identifying the ‘edges’ of cylindrical 
features.  Re-start the centreline command.  This time select the two 
edges of the small bore in the ELEVATION.   

 
Note the symbol indicating that you have placed the cursor on the correct 
‘edge’.  
 
Select the edge, it will turn green; (See Figure 22) continue to select the 
opposite edge of the bore.  Once again the symbol indicates that the 
cursor is on the bore ‘edge’.  Select this second edge to complete the 
command.  The centreline is placed.   
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Figure 22 

 
Repeat the above steps for the small bore in the PLAN.  When you are 

finished, choose the green tick  to close the Centreline Property 
Manager. 

 
24. Some section views would be useful for the drawing of this part.  We 

will use the ‘Broken-out’ section in two places. 
 

From the ‘Sketch Toolbar’ choose ‘Circle’ .  The pencil/circle symbol 
appears on screen and we will now draw a circle to establish the area 
for the broken-out section.  Place the cursor pencil/circle symbol as 
indicated in Figure 23 and draw a circle as shown below. 
 

 
Figure 23 

 
25. From the ‘Drawing Toolbar’ select ‘Broken-out Section’.   

See Figure 24. 
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Figure 24 

 
The Broken-out Section Property Manager opens.   
 
Check the ‘Preview’ box.  If a message box opens on your screen 
choose OK.   
 
Notice that a yellow cutting plane is shown on the PLAN and RIGHT END 
ELEVATION.  See Figure 25. 
 

    
Figure 25 

 
The Property Manager indicates a default depth of 10mm.  Press the up 
arrow to increase the depth to 20mm.   
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Notice that the yellow cutting plan moves by 10mm and that the broken-out 
section now appears inside the circular area.   
 
Press the up arrow and increase the depth to 50mm, watch the cutting 
plane move and the effect it has on the broken-out section.  The cutting 
plane is now close to the centre of the small boss & bore.  See Figure 26.  
 

 
Figure 26 

 
We want the cutting plane to pass through the boss & bore, exactly on 
its centre.  To achieve this we may select the circle that represents the 
diameter of the boss.  Place the cursor on the boss circle.   
 
Notice that it is highlighted; there is an edge symbol next to the cursor and a 
note indicating the feature (Extrude 3 of Housing).  See figure 27. 
 

 5-16



 
Figure 27 

 
Left click to accept the boss feature.  The yellow cutting plane is now 
exactly on the boss/bore centre, the broken-out section is complete and 
Edge<1> is listed in the depth window of the Broken-out Section 
Property Manager.  See Figure 28.     
 

 
Figure 28 

 

26. Select the green tick  to end the command. 
 

27. On your own, use the same procedure to create a second Broken-out 
Section for the counterbore hole.  See Figure 29. 
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Figure 29 

 
Notice that the broken-out sections are added to the design tree. 
 

28. In the section view, normally hidden edges are not shown.  Select the 
ELEVATION and switch off the hidden edges.  See Figure 30. 

 

 
Figure 30 

 
SAVE YOUR WORK! 

 
29. We are now ready to insert the dimensions.  Place the cursor over the 

‘Insert’ dropdown menu at the top of your screen and open.  Choose 
‘Model Items…’  See Figure 31.  ‘The Insert Model Items’ dialog box 
opens.  Ensure that the ‘Dimensions’, ‘Import items into all views’ 
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and ‘Eliminate duplicate model dimensions’ boxes are checked.  
Choose OK to insert the dimensions.  See Figure 32. 

 

 
Figure 31 

 

 
Figure 32 

   
Note that the dimensions are not arranged well.  The software simply dumps 
the dimensions from the model into the drawing file. See Figure 33.   We 
must now re-arrange the dimensions to conform to International 
Standards. 
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Figure 33 

 
30. First, we should hide dimensions that may be given in a note.  The 

most suitable note dimension is the R3 fillet.  Place the cursor over one 
of the R3 fillet dimensions and right click.  See Figure 34. 

 

 
Figure 34 

 
From the short-cut menu choose ‘Hide’, the dimension is hidden from 
view.  Continue to hide all other R3 fillet dimensions.  See Figure 35. 
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Figure 35 

 
31. The location dimensions of the small boss/bore are best shown in the 

RIGHT END ELEVATION, therefore the dimensions should be 
moved from their present locations to this view.  To do this hold down 
the control key as you select the dimension with the left button of the 
mouse, then drag the dimension to the END ELEVATION.  Drop the 
dimension at the location shown in Figure 36.   

 

 
Figure 36 

 
Notice the symbol change as the cursor is moved from the original view to the 
new location. 
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32. Other dimensions may be moved to better locations within a view by 
selecting them with the mouse, left clicking and hold as the dimension 
is dragged to a new position.  When finished, your drawing should 
look similar to Figure 37. 

 

 
Figure 37 

 
33. When modifying dimensions in the drawing it will be necessary to 

save both the drawing and its referenced model.  When this must be 
done a dialog window will open asking if you wish to save the 
referenced models.  When this happens it is best to answer ‘yes’.  Both 
the active drawing and its referenced model will be saved.  

 
SAVE YOUR WORK! 

 

 
Figure 38 
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34. The dimension font, font size, arrow style and arrow size may be 

changed globally.  From the ‘Tools’ drop down menu choose 
‘Options…’, See Figure 38.  The System Options dialog box opens, 
usually at ‘General’.  Select the ‘Document Properties’ tab.  Under 
‘Detailing’ select ‘Dimensions’.  See Figure 39.  In the ‘Arrows’ area, 
choose the down arrow to view and select an arrow style.   

 
Figure 39 

35. Choose ‘Annotations Font’ under ‘Detailing’ and from the annotations 
type window select ‘Dimension’.  From the dialog box select ‘Book 
Antigua’ and set the Height to 12 points.  Select OK to close the box.  
See Figure 40. 

 

 5-23



 
Figure 40 

 
The drawing dimensions and arrows should now have the size and 
font selected.  See Figure 41. 
 

 
Figure 41 

 
36. We should now add the note to give the dimension for the rounds & 

fillets that we have hidden.  Choose ‘Note’ from the ‘Annotations 
Toolbar’ as before.  Place the note box in a suitable location (See 
Figures 42 and 43.) and type  ‘Rounds & fillets to be R3 

                                    Unless otherwise stated’ 
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Figure 42 

 

 
Figure 43 

 
37. To finish we may now add a pictorial view of the model.  From the 

‘Drawing Toolbar’ select the ‘Named View’ button.  See Figure 44.  
The Named View Property Manager opens and indicates four methods 
of selecting the model.  See Figure 45.  We will use method 1 for this 
drawing.  
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Figure 44 

 

 
Figure 45 

 
38. Place the cursor close to the PLAN view and left click once.  A view 

orientation window opens in the Property Manager and the cursor 
changes to indicate that a named view may now be selected from the 
list offered.  In the window ensure that ‘ISOMETRIC’ is highlighted, 
you may also check the preview box.  Place the isometric view in a 
suitable location at the top right corner of the border.  (You may 
experiment with some other choices such as Trimetric or Dimetric.)  

When you have placed the view choose the green tick  to complete 
the command.  See Figure 45. 

 
Notice that the ‘tangent edges’ are visible in the isometric view.  These edges 
may be displayed with different types of lines.   
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39. Right click close to the ISOMETRIC VIEW and from the short-cut 
menu select ‘Tangent Edge’.  A further menu slides out to the side and 
offers three choices; ‘Tangent Edges Visible’, ‘With font’ or 
‘Removed’.  Choose ‘Tangent Edges With Font’.  Your model will now 
display the Isometric view tangent edges as phantom lines.   
See Figure 46. 

 

 
Figure 46 

 
40. Finally, we may add colour to the Isometric view.  Left click close to 

the isometric view and select ‘Shaded’  from the ‘View Toolbar’.  
You may need to left click anywhere in the graphics area to re-generate 
the drawing.    
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Figure 47 The complete Drawing 

 5-28



Module 6: To Create a 2-D Working Drawing 
 

1. Open the Housing drawing. 
 

2. The first enhancement we will add to the drawing will be layers.  Figure 1 
indicates the route to the layer toolbar.  Go ahead and open the layer toolbar.  
The toolbar may ‘float’ or may be ‘anchored, (fixed) at a convenient location 
on your screen. 

 

 
Figure 1 

 
3. Open the layers Property Manager, Figures 2 & 3. 
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Figure 2 

 

 
Figure 3 

 
4. In the Layers Property Manager create a new layer by selecting the ‘New’ 

button.  Give this layer a new name ‘dimensions’, and a new colour (you may 
choose your own colour for the layers). 

 
5. Create two more layers.  One called ‘Machine Symbols’ and the other called 

‘Tolerances’.  Give each layer a different colour.  See Figure 3. 
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6. We may now change from one layer to another by using the ‘down arrow’ of 
the layer toolbar. 

 
7. To place the dimensions on the dimension layer.  Holding the control key 

down, select each dimension in turn.  As each dimension is selected, it is 
identified on screen by green markers.  When all dimensions are selected, use 
the down arrow of the layer toolbar to select the ‘dimension’ layer.  The 
active dimensions are now transferred to this layer and take on the colour you 
have set.  See Figure 4.  Select OK  from the dimensions Property Manager 
to end the command. 

 

 
Figure 4 

 
8. Line thicknesses may be changed from the ‘Tools’, ‘Options…’ drop down 

menu.  Open the Systems Options window and select ‘Document Properties’.  
Select ‘Line Font’.  See Figure 5.  From this window we may choose many 
‘types’ or ‘styles’ of lines and choose their ‘thicknesses’.  Make the following 
settings in this window; 

 
i. Visible Edges……… Style: ‘Solid’ Thickness:  ‘Thick’ 

ii. Hidden Edges…….... Style: ‘Dashed’  Thickness:  ‘Normal’ 
iii. Dimensions………... Style:  ‘Solid’ Thickness:  ‘Thin’ 

 
Choose OK  to close the window and view the results on screen.   
See Figure 6. 
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Figure 5 

 

 
Figure 6 

 
9. Save your drawing as ‘Enhanced Housing Drawing xxx’. 
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10. Three of the diameters require limits.  These are the Ø30 bore, the Ø48 bore 
and the Ø16 bore.  The assignment sheet asks for an ‘H7 tolerance’ on each 
of these diameters.  To add tolerances to dimensions first, select Ø30 to 
activate it, See Figure 7, this will open the dimension properties manager.  In 
the ‘Tolerance Type’ window choose ‘Fit with tolerance’.  From the 
‘Classification’ window choose ‘Press’.  From the ‘Hole Fit’ window choose 
‘H7’.  From the ‘Primary Unit Precision’ and ‘Tolerance Precision’ 
windows choose (.XXX [three decimal places]).  See Figure 8, and select 
OK   to complete the command. 

 

 
Figure 7 
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Figure 8 

 
11. Select the Ø30 dimension and place it on the tolerances layer.  Notice the 

change of colour as it moves from one layer to the other.  See figure 9. 
 

 
Figure 9 
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12. Now add an H7 tolerance to the other two diameters.  When complete, move 
these two diameters to the tolerance layer. 

 
13. Use the ‘Zoom to Area’ tool  to look more closely at Ø16.  You will notice 

that the data does not fit well into the available space.  We can display the data 
in several ways.  In the ‘Tolerance Type’ window select ‘Limit’.  Notice that 
the maximum and minimum limits are now displayed for this dimension, and 
that it fits better into the space.   Use ‘Zoom to Fit’  to return to the full 
drawing.  See Figure 10. 

 
SAVE YOUR WORK!! 

 
14. We need to add machine symbols (surface texture/finish) to the drawing where 

they are needed.  Set the ‘Machine Symbols layer’ active.  From the 
‘Annotations Toolbar’ select ‘Surface Finish’ See Figure 10. 

 

 
Figure 10 

 
15. The Surface Finish Symbol Properties window opens.  Notice the preview 

window.  In the ‘Symbol Window’ choose ‘Machining required’.  Notice 
the change in the preview window.  In the ‘Direction of Lay’ window choose 
‘Circular’.  In the ‘Roughness Maximum’ window enter a value of 0.8 (µm).  
In the ‘Material removal Allowance’ window enter a value of 3.5 (mm).  
Notice the symbol being built in the preview widow.  We DO NOT WISH to 
use Leader Lines to place the symbols, so ensure that ‘No Leaders’ is 
selected.  We may control the size of the symbol by using the ‘font’.  Un-
check the ‘Use documents font’ box and open the font dialog box.  Change 
the font to ‘Book Antigua’ with a height of 12 points.  Notice that the symbol 
in the preview box shows these changes as they are entered.  See Figure 11. 
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Figure 11 

 
16. We are now ready to place the symbols in the drawing.  Move the cursor into 

the drawing/graphics area of the screen.  DO NOT CLICK THE MOUSE!   
 
Notice that the machine symbol is attached to the cursor.  The symbol may 
now be attached to all surfaces that have to be machined.  See Figure 12.  
However, the Properties Window is covering most of the drawing.  The 
window must be moved out of the way.  (Note; DO NOT CLOSE THE 
WINDOW).   
 
To move the window place the cursor into the blue bar at the top, hold down 
the left button and drag the window to the left of the screen.  This will uncover 
the drawing.  Most of the window is now ‘out of sight’.  Place the symbols, 
one by one, onto the surfaces indicated in Figure 12.  Notice that you may 
place as many symbols as are needed.  When all symbols are in place we may 
close the Properties Window to end the command. 
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Figure 12 

 
17. The dimensions and machine symbols may need to be moved a little if they 

overlap each other or if they are too close together.  We may drag the 
dimensions or the symbols to better locations within the views by selecting 
them with the left button of the mouse and holding the button down as we 
drag.  When you are finished your drawing should look similar to Figure 13. 

 
SAVE YOUR WORK!! 
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Figure 13 
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Module 7: Construct Bushes and Produce Detail Drawings 
 
Create models and detail drawing for the bushes given in Figures 1 and 2. 

 
Figure 1 Bushing 

 

 
 

Figure 2 Plain Bush 
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Module 8: Assembling Housing Parts 
 

1. Open the Housing and the small bush. 
 

2. From ‘New’ open an Assembly File  and select ‘Tile 
Horizontally’.  See Figures 1 & 2. 
 

 
Figure 1 
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Figure 2 

 
Notice the ‘Assembly Design Tree’ and the ‘Assembly Toolbar’.  In Figure 3, 
the screen displays all three windows. 

 

 
Figure 3 
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3. Drag the ‘Housing icon’ from the top of the HOUSING FEATURE 
MANAGER TREE in the Housing part window, and drop it in the 
FEATURE MANAGER DESIGN TREE OF THE ASSEMBLY 
WINDOW.  See Figure 4. 
 

 
Figure 4 

 
Notice the shape of the cursor as you move into the Feature Manager Design 
tree of the assembly.  When the main part of an assembly is added this way, 
the part is fixed at the assembly file origin. 

 
• The origin of the part coincides with the origin of the assembly origin. 
• The part and assembly planes are aligned. 

 
4. Drag the ‘small bush icon’ from the top of its FEATURE MANAGER 

DESIGN TREE window, and drop it in the GRAPHICS AREA of the 
assembly window close to the Housing.  See Figure 5. 
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Figure 5 

 
Notice the cursor symbol as the small bush is dropped in the assembly 
graphics area.   
 

5. Save as ‘Housing Assembly xxx’.  See Figure 6 
 

 
Figure 6 
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Notice that the file extension is now (*.sldasm) indicating an assembly file.  
We no longer need the part files, but it is useful to keep them open. 
 

6. Maximise the assembly window and ‘Zoom to Fit’ .  See Figure 7.  We 
must now create ‘Mate Relations’ between these two parts, first to align them 
and then to fit them together.  Click ‘Isometric’  then click ‘Mate’ from the 
Assembly Toolbar.  See Figure 8. 

 

 
Figure 7 
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Figure 8 

 
The ‘Mate Property Manager’ opens.  Notice that the ‘Entities to Mate’ 
window is active (pink,) See Figure 9.  We must now select the surfaces or 
edges that are to be ‘mated’.    

 

 
Figure 9 
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7. Place the cursor on the outer cylindrical surface of the small bush, and left 

click to select it.  The surface is highlighted, the cursor flag is visible and the 
selected surface is added to the ‘Entities to mate’ window.  Now place the 
cursor on the small bore at the right side of the housing.  See Figures 10 & 11. 

 

 
Figure 10 

 

 
Figure 11 

 
Select the bore surface as before.  Notice that this second surface is added to 
the ‘Entities to mate’ window.  All possible mate settings are now available. 
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Choose ‘Concentric’  as the mate type and ensure that ‘closest’ is selected 
as ‘Mate Alignment’.  Click ‘Preview’ and watch the small bore align itself 
with the centre of the bore.  See Figure 13. 

 

 
Figure 12 

 
Click OK   to accept the mate. 

 
8. The position of the small bush is not fully defined, as indicated by the (-) sign 

in the Feature Manager Design tree.  We must now lock the small bush in its 
final position. 
 
Select ‘Mate’ once again; select the flat face at the right end of the bush.  
Now, select the flat face at the right end of the small boss.  Both of these faces 
are highlighted and the mate choices are available.  See Figures 13 & 14. 
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Figure 13 

 

              
Figure 14 

 
Choose ‘Coincident’   and watch as the bush moves into its final position.  
Click OK  to end the command.  See Figure 15. 
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Figure 15 

 
Save your work!! 

 
9. We must now place the large bush in position.   

 
From the ‘Insert’ drop down menu select ‘Component’ & ‘From File’.  See 
Figure 16. 

 

 
Figure 16 
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Drop the big bush in the graphics area of the screen.   
 
Note the cursor symbol as you do this.  
  
Now, on your own, mate the big bush to the counterbore of the Housing.  
When you are finished, your assembly should look similar to Figure 17. 
 

 
Figure 17 

 
Notice that both bushes still have a (-) sign in the design tree.  Why should this 
be?  Which degree of freedom is still not constrained? 
 

10. Save your work !! 
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Module 9: Assembly Drawing with Bill of Materials 
 

1. Open the A3 Template Drawing Border 
 

2. Save as ‘Housing Assembly xxx’. 
 

3. Insert the 3 Standard Views from the Housing Assembly Model File. 
 

4. Add the Broken out sections indicated in Figure 1. 
 

 
Figure 1 

 
5. Create a layer and use the ‘dimension tool'  to add the dimensions shown 

above. 
 

6. We must now edit the cross hatch pattern for the bushes.  Place the cursor in 
the cross hatch area of the big bush, ‘right click’ and select ‘Properties’.  In 
the ‘Area Hatch/Fill’ Properties box make the changes shown in Figure 2.  
Choose ‘Apply’ to close the window.    
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Figure 2 

 
7. Repeat the above procedure for the small bush. 

 
8. Rebuild  the drawing and save ! 

 
9. We are now ready to build and insert the ‘Bill of Materials’.  From the 

‘Tools’ dropdown menu navigate to ‘Document Properties’ and ‘Detailing’.  
Make sure that ‘Automatic Update of Bill of Materials’ checkbox is 
selected.  See Figure 3. 
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Figure 3 

 
10. Go to ‘Balloons’; in the ‘Single Balloon’ area style window, select ‘Circular 

Split line’.  In the ‘Balloon Text’ area set ‘Upper:’ to ‘Item Number’ and 
‘Lower:’ to ‘Quantity’.  In the ‘Bent Leaders’ area check the ‘Use Bent 
Leaders’ box.  See Figure 4. 

 

 
Figure 4 

 
11. Go to ‘Annotations Display’ and make sure that ‘Display all types’ is 

checked.  See Figure 5. 
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Figure 5 

 
12. Left click OK  to close the ‘Options’ Dialog box. 

 
13. Left click to select the ‘Elevation’, and from the ‘Insert’ drop down menu 

choose ‘Bill of Materials’.  See Figure 6. 
 

 
Figure 6 
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14. From the select ‘Template Window’ accept the default template, 

‘bomtemp.xls'.  The ‘Bill of Materials Properties Window’ opens.   
See Figure 7. 
 

 
Figure 7 

 
15. Make sure that the following settings are in place: 

 
• Clear the ‘Use documents note font when creating the table’. 
• Choose ‘Show assemblies and parts in an indented list’. 
• In the Anchor point area check ‘Use table anchor point’. 
• Set Anchor point coincident to ‘Top Left’. 

 
Now click OK to compile and display the ‘Bill of Materials’. 
 

16. Right click in the ‘Bill of Materials’ and select ‘Anchor, Top Right’.  See 
Figure 8. 
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Figure 8 

 
 Notice that the ‘Bill of Materials’ is attached to the drawing border at the Top 
Right corner.  By changing the ‘Bill of Materials’ anchor point to Top Right these 
two corners will be coincident. 
 

17. Use the ‘Zoom to Area’ tool   and zoom to enlarge the Bill of Materials.  
Right click in the bill of materials and choose ‘Edit Bill of Materials’.  When 
the Bill of materials is active, it is displayed with a shaded border, with row 
and column headers and the Excell toolbars replace the SolidWorks toolbars.  
See Figures 9 & 10. 
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Figure 9 

 

 
Figure 10 

 
18. We wish to edit the contents.   

 
• In cell A1 delete ‘Item No.’ and replace it with ‘Part No.’. 
• In cell C1 delete ‘Part No.’ and replace it with ‘Description’. 
• In cell D1 delete ‘Description’ and replace it with ‘Material’. 
• In cell D2 enter ‘Cast Iron’. 
• In cells D3&D4 enter ‘Ph. Bronze’. 

 
See Figure 11. 
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Figure 11 

 
19. We may also change the font, re-size the text and so on.  Select ‘Book 

Antiqua’ with a font size of ‘22’.  From ‘Format’ select ‘Row’ and 
‘AutoFit’.  Then select ‘Column’ and ‘AutoFit Selection’.  

 
20. Left click outside the ‘Bill of Materials’ to close Excell and return to 

SolidWorks, with the updated data.  See Figure 12. 
 

 
Figure 12 

 
Save your work! 
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21. We now add ‘Balloon References’ to the drawing; click ‘Balloon’ on the 

‘Annotations Toolbar’.  The ‘Balloon Property Manager’ opens.   
See Figure 13. 
 

 
Figure 13 

 
22. Left click a component in the drawing view.   

 
A balloon attaches itself to the part.  The numbers correspond to the part 
number and the quantity listed in the Bill of Materials.   
 

Add Balloons to the other two parts then click OK .  To move the balloon 
or its leader arrow, select and drag by the green handles.  See Figure 14.  
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Figure 14 
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Module 10: Sectional Views  
 

1. Open a ‘New Part’ file and set the units to inches, decimal and three places.  
See Figure 1. 

 

 
Figure 1 

 
2. Open a Sketch on the Top Plane and sketch the profile shown in Figure 2. 

 

 
Figure 2 

 
3. Select the ‘Revolved Boss/Base’ tool  to create a revolved model from the 

sketch. 
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Figure 3 

 
Accept the default revolve type and angle settings, click OK  to generate the 
solid model. 
 

4. Save as ‘Bearing Fig 7_41’. 
 

5. We must now place the 4 bolt holes in the flange.  Select the front face of the 
flange and open a sketch on this surface.  Select ‘Normal To’  and draw a 
circle as shown in Figure 4. 

 

 
Figure 4 

 
6. Select ‘Extruded Cut’  to form the bolt hole ‘Through All’. 
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7. Turn on ‘Temporary Axes’ from the ‘View’ dropdown menu.  Select 
‘Circular Pattern’ , the Circular Pattern Properties Manager opens with 
‘Cut-Extrude1 listed in the Features to Pattern field.  The ‘Pattern Axis’ field 
is pink; select the temporary axis that passes through the flange bore.  Axis 
<1> is now listed and a preview of the patterned features is shown on screen.  
Increase the number of instances from 2 to 4 by using the ‘up arrow’.  Notice 
the preview changing as the value changes.  Select OK  See Figure 5. 

 

 
Figure 5 

 
8. The model is complete and we may now turn off the temporary axes. 

 
Save your work!!! 

 
9. Now that the model is complete we must now prepare an Imperial drawing 

border.  Using your previous instructions set up an imperial border using ‘C-

Landscape’ as your base template.   
 

Ensure that:  
 

• Units are set to inches and 3 decimal places. 
• Scale is set to 1:1. 
• Type of projection is ‘Third Angle’. 
• Drawing Title is ‘Bearing’. 
• Material is ‘Cast Iron’. 
• Finish is ‘See Machine Symbols’ 
• ‘KFUPM Mech. Eng. Dept.’ is added. 
• Your family name, ID No and section number are given 
• The date is added.  
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10. Insert the three orthographic views with tangent edges removed.  Position the 
views carefully within the border.  You will have to modify the DWG. NO. 
(Use ‘Properties’).  See Figure 6. 

 

 
Figure 6 

 
11. We will add a ‘Full Section’ to replace the Right End Elevation.  Select the 

‘Section View’ button from the ‘Drawing View’ toolbar.  Place the cursor 
above the vertical centre line of ‘Elevation’ left click once and draw the 
section line (cutting plane) vertically down through the model to the bottom.  
Notice the cursor symbol change as it indicates what you are doing.   

 
When you have drawn the line to the bottom of the model, left click once. 

 
Notice that the cutting plane with viewing direction arrows is added to the 
Elevation and that the ‘Section View’ appears on screen.  The ‘Section View 
Property Manager’ is open.  The cutting plane arrows may be pointing in the 
wrong direction.  If so, we can use the ‘Flip direction’ by checking the box in 
the property manager.   
 
Left click to check the box and observe the result on screen.  When you have 
the desired Section View left click once in the graphics area to place the view 
(with tangent edges removed).  See Figure 7. 
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Figure 7 

 
12. The Standard Right End Elevation is not required and may be hidden.  Right 

click inside the border of this view and choose ‘Hide View’.  See Figure 8. 
 

 
Figure 8 

 
13. Now we need to add centre lines to the views.  Activate the section view and 

select ‘Centreline’ from the ‘Annotations’ toolbar.  Centrelines are placed 
through the cylindrical parts.  Switch on ‘Hidden Edges’ for the Plan and 
repeat the procedure for the Plan.  See Figure 9. 
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Figure 9 

 
14. The Cutting Plane Line Font may need to be changed from the default.  To do 

this select:  Tools, Options, Document Properties and Line Font.  Select 
‘Section Line’ and choose ‘Chain’ from the ‘Style’ list and set ‘Thin’ for the 
‘Thickness’.  

 

 
Figure 10 

 
15. Create layers for Dimensions and for Machine Symbols.  Set the machine 

symbols layer current and add the symbols as shown in Figure 10.  The Ra 
value should be 32µ in. and Machine Allowance is to be 3/16” (.1875”).  Use 
the ‘Font’ to control the size of the symbol. 
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16. We may add the data for Rounds & Fillets.  Use the ‘Note’ button and add 
‘Rounds & Fillets R .12’. 

 
17. From ‘Insert’ Model Items, insert the dimensions on the dimensions layer.  

Re-arrange the dimensions as shown in the Figure 10. 
 

 
Figure 11 

 
18. The bore dimension has a maximum and minimum limit.  This may be added 

as follows; Select the bore diameter dimension.  The Dimension Property 
Manager’ opens and we may select ‘Limit’ from the ‘Tolerance Type’ 
window.   
The base sketch used the ‘Minimum Limit’ diameter for the model 
construction, therefore we do not need to change the ‘–ve’ value.  The 
‘Maximum Limit’ for the bore is Ø1.500 therefore we need to enter 0.002 in 
the ‘+ve’ field.  Ensure that 3 decimal places are shown in the precision 
fields.  See Figure 11. 
 
Select OK to update the dimension.  Save your work!!! 
 

19. We need to dimension the four bolt holes.  Select the ‘Dimension’ tool , 
choose the hole at the top of the Elevation and place the dimension.  In the 
Property Manager edit the dimension to remove the brackets and add the data: 

 
Ø0.500 Four holes 
Equally spaced on Ø4.24 
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Figure 12 

 
20. To complete the drawing add a pictorial view of the part showing tangent 

edges ‘with font’.  See figure 13. 
 
 

 
Figure 13 
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Module 11: Reference Planes; Vertical Bearing Support 
In this Tutorial, the creation and usage of reference geometries are demonstrated. The 
model of Vertical Bearing Support is as shown in Figure 1. 

 

 
Figure 1 Vertical Bearing Support 

It can be built by following the procedures as shown in Figure 2. 

1. Create a base using Extruded Boss/Base. 

2. Add a slot boss for creating the slot body. 

3. Create a plane for slot body with At Angle, and then a Slot body. 

4. Cut the Slots on the slot body and the base. 

5. Add hole bosses for drilling holes. 

6. Drill holes and add fillets. 

   
 

   
Figure 2 Modeling process of Vertical Bearing Support. 
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Create Support Base 
1. Start Solid Works 

2. Select New  on the Standard toolbar, or click File, New on the menu bar. 

3. Select Part  from the Template tab in the dialog box, and click OK. 

4. Click File, Properties on the menu bar. 

5. Fill in the necessary properties in the dialog box, and click OK to accept the 
properties and close the dialog box. 

6. Click Tools, Options on the menu bar to open the option dialog box. 

7. Select the Document Properties tab, and click Unit in the properties tree text box. 

8. Select Millimeter and set the decimal places to 2. 

9. Click OK to close the Properties dialog box. 

10. Select Top Plane in FeatureManager design Tree and click Normal To  to 
bring Top plane parallel to the screen. 

11. Select Sketch  on the Sketch toolbar to open a new sketch on the Top Plane. 

12. Select Rectangle  on the Sketch Tools toolbar, and draw a rectangle. 

13. Select Fillet  on the Sketch Tools toolbar to fillet the four corners of the rectangle. 

14. Select Dimension  on the Sketch Relation toolbar, and dimension the sketch as 
shown in Figure 3. To change the fillet radius to 32 mm, double click on fillet 
dimension, Modify dimension window will open, type 32 and press Enter. 

15. Click Zoon to Fit  to see the entire sketch. 

 
    Figure 3 Base sketch and dimensions 

16. Select Extrude Boss/Base  on the Features toolbar. The Base-Extrude 
PropertyManager appears. 

17. Select Blind in the End Condition drop down list box. 

18. Type 32mm in the distance 1 box as shown in Figure 4. 

19. Click OK  to finish the base extrusion. 
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    Figure 4 Base extrude 

Create an Offset Plane and a Support Boss 

1. Click Plane  on the Reference Geometry toolbar, or click Insert, Reference 
Geometry, Plane on the menu bar. 

2. Select Offset Distance  on the PropertyManager. 

3. Select the side face of the base as shown in Figure 5. Its name appears in the 
Selection text box. 

4. Enter 140mm in the Distance text box. 

5. Select the Reverse Direction check box. 

6. Click OK . The Planel is created and displayed in the FeatureManager Design 
Tree. 

 
Figure 5 Offset plane 

7. Select the Planel in the FeatureManager Design Tree or graphics window. 

8. Select Sketch  on the Sketch toolbar to open a new sketch. 

9. Click Normal To  on the Standard Views toolbar to make the sketch plane 
parallel to the screen. 

10. Select Line  on the Sketch Tools toolbar to draw a polygon at the left edge of the 
part. The right vertical line of the sketch should align with the left edge of the part. 
Its two endpoints should be coincident with the endpoints of left edge of the part. 
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11. Select Dimension  on the Sketch Relation toolbar, and dimension the sketch as 
shown in Figure 6. 

 
Figure 6 Boss sketch 

12. Select Extrude Boss/Base  on the Features toolbar. 

13. Click Isometric  to have 3-D visualization. 

14. Select Mid Plane in the end condition drop down list box. 

15. Type 130 mm in the distance 1 text box as shown in Figure 7. 

16. Click OK  to finish the boss extrusion. 

  
  Figure 7 Boss extrusion parameters 

 Create an Angle Plane and a Slot Body 

1. Click Plane  on the Reference Geometry toolbar, or click Insert, Reference 
Geometry, Plane on the menu bar. 

2. Click At Angle  in the dialog box, and then select the front face of the boss in the 
graphics window. Its name appears in the Selections text box. 

3. Select the edge of the boss tip as shown in Figure 8. 
4. Type 30 in the Angle text box. 

5. Click OK  . The Plane2 is created and displayed in the FeatureManager Design 
Tree. 
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Figure 8 Plane At Angle for slot body 

 
6. Select the Plane2 in the FeatureManager Design Tree or in the graphics window. 

7. Select Sketch  on the Sketch toolbar to open a new sketch. 

8. Click Normal To  on the Standard Views toolbar to make the sketch plane parallel 
to the screen. 

9. Select Rectangle  on the Sketch Tools toolbar and draw a rectangle whose top 
edge aligns with the top edge of the part. 

10. Select Dimension  on the Sketch Relation toolbar. Dimension the rectangle as 
shown in Figure 9. If the sketch is not fully constrained, apply collinear constraint to 
the vertical lines and edges. 

 
    Figure 9 Slot body sketch 

11. Select Extrude Boss/Base  on the Features toolbar. 

12. Select Blind in the end condition drop down list box. 

13. Type 32 mm in the distance 1 text box as shown in Figure 10. 

14. Click Reverse Directionto flip the extrusion direction 

15. Click OK  to finish the slot body extrusion. 
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Figure 10Slot Body extrusion parameters 

16. Select Fillet  on the Features toolbar. 

17. Select two top side edges of the slot body as shown in Figure 11. 

18. Type 20 mm in the Radius text box. 

19. Click OK  to finish the fillet. 

 
  Figure 11 Slot body fillets 

Cut Slots 

1. Select the top face of the slot body as shown in Figure 12. 

 
Figure 12 Sketch surface for slot cut 

2. Select Sketch  on the Sketch toolbar to open a new sketch. 

3. Click Normal To  on the Standard Views toolbar to make the sketch plane 
parallel to the screen. 
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4. Select Centerline  on the Sketch Tools toolbar to draw a horizontal centerline as 
the symmetric axis of the sketch. 

5. Select Line  on the Sketch Tools toolbar to draw the sketch of the slot that is 
symmetric to the sketched centerline. 

6. Select Add Relation  on the Sketch Relation toolbar to add symmetric constraints 
to the sketch. (Note: Apply the symmetric constraint first to the centerline with the 
part edges to make the centerline symmetric to the part). 

7. Select Dimension  on the Sketch Relation toolbar, and dimension the sketch as 
shown in Figure 13. The sketch will be fully constrained. If not, apply more 
constraints. 

   
Figure 13 Slot sketch 

 
8. Select Extruded Cut  on the Features toolbar. 

9. Select Through All in the end condition drop down list box as shown in the Figure 
14. 

10. Click OK  to finish the slot cut. 

   
Figure 14 Slot cut parameters 

11. Select back surface of the base feature as the sketch plane of the bottom as shown in 

Figure 15. You may rotate the part using Rotate View  to make back surface 
directly visible. 
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Figure 15 Sketch plane for bottom slot 

12. Select Sketch  on the Sketch toolbar to open a new sketch. 

13. Click Normal To  on the Standard Views toolbar to make the sketch plane 
parallel to the screen. 

14. Select Centerline  on the Sketch Tools toolbar to draw a horizontal centerline as 
the symmetric axis of the sketch. 

15. Select Line  on the Sketch Tools toolbar to draw a sketch of the slot that is 
symmetric to the sketched centerline. 

16. Select Add Relation  on the Sketch Relation toolbar to add symmetric constraints 
to the sketch. (Note: Apply the symmetric constraint first to the centerline of the part 
edge to make the centerline symmetric to the part). 

17. Select Dimension  on the Sketch Relation toolbar, and dimension the sketch as 
shown in Figure 16. The sketch will be fully constrained. If not, apply more 
constraints. 

 
    Figure 16 Bottom slot sketch 

18. Select Extruded Cut  on the Features toolbar. 

19. Select Through All in the end condition drop down list box as shown in the Figure 
17. 

20. Click OK  to finish the bottom slot cut. 
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Figure 17 Bottom slot cut parameters 

 

Create Bosses on the Base 
1. Select the top face of the base as the sketch plane of the hole bosses as shown in 

Figure 18. 

 
    Figure 18 Sketch plane for hole boss 

2. Select Sketch  on the Sketch toolbar to open a new sketch. 

3. Click Normal To  on the Standard Views toolbar to make the sketch plane 
parallel to the screen. 

4. Select Centerline  on the Sketch Tools toolbar to draw a horizontal centerline as 
the symmetric axis of the sketch. 

5. Select Centerpoint Arc  on the Sketch Tools toolbar, and draw two arcs (two 
half-circles) to form the top and bottom edges of the sketch. 

6. Select Add Relation  on the Sketch Relation toolbar. 

7. Click Keep Visible  on the PropertyManager to activate the command. 

8. Select two arcs, and apply equal  constraint. 

9. Select the top arc and the top edge arc of the part, and apply Concentric  
constraint. 
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10. Select the bottom arc and the bottom edge arc of the part, and apply Concentric  
constraint. 

11. Select the centerline and the two outside edges of the part, and apply symmetric  
constraint. 

12. Select Line  on the Sketch Tools toolbar, and draw two lines to close the sketch. 

13. Select the sketch and the centerline by drawing a window around them (you may add 
entities to selection by holding the ‘Control’ key and clicking on he required entities 

one by one), and click Mirror  on the Sketch Tools toolbar to mirror the sketch 
to the other side. 

14. Select Dimension  on the Sketch Relation toolbar. Dimension the sketch as 
shown in Figure 19. 

 
     Figure 19 Hole boss sketch 

15. Select Extruded Boss/Base  on the Features toolbar. 

16. Click Isometric  to have 3-D visualization. 

17. Select Blind in the end condition drop down list box. 

18. Type 3 mm in the distance 1 box as shown in Figure 20. 

19. Click OK . 

 
Figure 20 Hole Boss Extrusion Parameters 
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20. Select the back surface of the base as shown in Figure 21. 

 
   Figure 21 Sketch plane for the counterbored hole boss 

21. Select Sketch  on the Sketch toolbar to open a new sketch.  

22. Click Normal To  on the Standard Views toolbar to make the sketch plane 
parallel to the screen. 

23. Select Centerline  on the Sketch Tools toolbar to draw a horizontal centerline as 
the symmetric axis of the sketch. 

24. Select Add Relation  on the Sketch Relation toolbar. Select the centerline and the 

two side edges of the part, and apply Symmetric  constraint. 

25. Select Centerpoint Arc  on the Sketch Tools toolbar, and draw a half circle 
whose center is coincident with the centerline. 

26. Select Line  on the Sketch Tools toolbar to draw three lines to close the sketch. 

27. Select Dimension  on the Sketch Relation toolbar, and dimension the sketch as 
shown in Figure 22. 

 
Figure 22 Sketch for counterbored hole boss 

28. Select Extruded Boss/Base  on the Features toolbar. 

29. Click Isometric  to have 3-D visualization. 

30. Select Blind in the end condition drop down list box. 

31. Type 70mm in the direction 1 box. 
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32. Click Reverse Direction  to flip the extrusion direction as shown in Figure 23. 

33. Click OK . 

 
Figure 23 Counterbored hole boss 

Create Holes and Fillets 
1. Select the end surface of the counterbored hole boss. 

2. Select the Hole Wizard  on the Features toolbar, and select the Counterbore tab. 

Note: Various types of holes can be created using corresponding tab. 

3. Select Up To Next in the End Condition & Depth cell. 

4. Type 22mm in the Hole Fit & Diameter cell. 45 mm and 50 mm in the Counterbore 
Diameter & Depth cells as shown in Figure 24. 

5. Click Next. 

  

    Figure 24 Counterbored Hole Parameters 

 11-12



6. Select Add Relation  on the Sketch Relation toolbar. 

7. Select the hole center point and the arc edge of the boss, and click Concentric . 

8. Click Finish to create the counterbored hole. 

9. Select the hole boss surface as shown in Figure 25. 

 
Figure 25 Sketch Plane for Base Holes 

10. Select Sketch   on the Sketch toolbar to open a new sketch. 

11. Click Normal To  on the Standard Views toolbar to make the sketch plane 
parallel to the screen. 

12. Select Circle   on the Sketch Tools toolbar, and draw one circle for the hole. 

13. Select Add Relation  on the Sketch Relation toolbar, and add concentric 
constraint to the circle with the arc edge of the base.  

Remark: You may similarly draw three other circles, Add Equal  constraint to 
the circles, but we will use another useful command to produce these circles.)  

14. Select Dimension   on the Sketch Relation toolbar. Dimension the circle diameter 
to 21mm as shown in Figure 26. 

 
Figure 26 Base Hole Sketch 
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15. Select Extruded Cut  on Features toolbar. Select Through All in the end 
condition drop down list box as shown in Figure 27. 

 
    Figure 27 Base holes 

16. Click 0K  . 

Copying Holes using Linear Pattern 
17. Make sure that Hole you have just created is selected in FeatureManager Design 

Tree. If not, select it by Clicking on it either in Graphic area or from FeatureManager 
Design Tree. 

18. Click Linear Pattern  on Feature Toolbar, Linear Pattern Prperty Manager 
opens as shown in Figure 28. 

 
Figure 28 Copying Features using Linear Pattern. 

19. Click on any edge parallel to Direction 1 as shown in Figure 28. 

20. Type 216 mm for Spacing . 

21. Type 2 for Number of Instances . A preview of the copied hole will appear as 
shown in Figure 28. Make sure that it is being copied in correct direction. If not, click 
on Reverse Direction . 

22. Click on any edge parallel to Direction 2 as shown in Figure 28. 
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23. Type 72 mm for Spacing . 

24. Type 2 for Number of Instances . A preview of the copied hole will appear as 
shown in Figure 28. Make sure that it is being copied in correct direction. If not, click 
on Reverse Direction . 

25. Click OK . 

26. Select the end face of the counterbored hole boss as shown in Figure 29. You may 
need to rotate the part. 

 
Figure 29 Sketch Plane for Reference Point 

27. Select Sketch  on the Sketch toolbar to open a new sketch. 

28. Click Normal To  on the Standard Views toolbar to make the sketch plane 
parallel to the screen. 

29. Select Point  on the Sketch Tools toolbar, and draw a point on the top edge of 
the counterbored hole boss. 

30. Select View, Temporary Axes on the menu bar to show the temporary axis for 
adding relation. 

31. Select Add Relation  on the Sketch Relation toolbar. 

32. Select the point and the edge. Click Coincident  to make the point coincident 
with the arc edge. 

33. Select the hole axis and the point as shown in Figure 30. Select Vertical  . 

34. Click Rebuild  on the Standard toolbar to exit sketch. 

35. Click Plane  on the Reference Geometry toolbar, or click Insert, Reference 
Geometry, Plane on the menu bar. 

36. Select On Surface . 
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Figure 30 Sketch Point for Creating On Surface Plane 

37. Select the cylindrical face of the boss and the sketch point as shown in Figure 31. 
Their names appear in the Selections text box. 

 
Figure 31 Top hole placement plane 

38. Click OK . The Plane3 is created and displayed in the FeatureManager Design 
Tree. 

39. Select Plane 3 in the Feature Manager Design Tree or in the graphics windows. 

40. Select Hole Wizard  on the Features toolbar. 

41. Select Tap tab in the Hole Definition dialog box. 

42. Select the parameters as shown in Figure 32. Click Next. 
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Figure 32 Top hole definition. 

43. Click Normal To  on the Standard Views toolbar to make the sketch plane 
parallel to the screen. 

44. Add constraints and dimension the hole center as sown in Figure 33. Then click 
Finish in the Hole Placement dialog box. (Note: There will be an error message in 
the dialoge box. Click OK to ignore it.) 

 
Figure 33 Top hole placement. 

45. Select the front face of the slot body as shown in Figure 34. 

 
Figure 34 Slot hole sketch plane 
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46. Select Hole Wizard  on the Features toolbar. 

47. Set up the Hole Definition Dialog box as shown in Figure 35. Then click Next. 

   
Figure 35 Slot hole definition 

48. Sketch a centerline and a point for the other hole. Add Symmetric  relation 
between two points and centerline. Dimension the hole centers as shown in figure 36. 

 
Figure 36 Slot hole placement. 

49. Click Finish in the Hole Placement dialog box. 

50. Add fillets as shown in Figure 37 and Figure 38 by using Fillet  on Feature 
toolbar. Use fillet radius as 6 mm. Final model for Vertical Bearing Support is shown 
in Figure 39. 

51. Save   the file. 
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    Figure 37 Base edge fillet. 

 
Figure 38 Slot body fillet. 

 

 
    Figure 39 Vertical bearing support model 
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Module 13: Sweep Features II: Candle Holder 
The Candle Holder is shown in Figure 1. 

 
Figure 1 Candle Holder Model 

It can be created by following steps: 

1. Create the individual sketches that make up the main base of the candle holder. Each 
sketch will be a simple 2D sketch.  

2. Draw a helix curve. 

3. Join using the Composite Curve command, the 2D sketch geometry and a helix will 
form a complex 3D path for the swept feature. 

To Create Model of the Candle Holder 
1. Start SolidWorks. 

2. Select New  on the Standard toolbar, or click File, New on the menu bar. 

3. Select Part  from the Template tab in the dialog box, and click OK. 

4. Click Tools, Options on the menu bar to open the option dialog box. 

5. Select the Document Properties tab. 

6. Click Unit in the properties tree text box. 

7. Select inches and set the decimal places to 3. 

8. Click OK to close the Properties dialog box. 

9. Select Top plane in the PropertyManager and click Top  on Standard View 
Toolbar. 

10. Select Sketch  on the Sketch toolbar to open a new sketch. 

11. Create and dimension the sketch shown in Figure 1. The sketch consists of a line and 
an arc. Make sure to fully define the geometry. 
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Figure 2 Creating the first sketch for the candle holder. 

12. Exit the first sketch. 

13. Create a new sketch on the Front plane. Sketch the geometry is shown in figure 3. 
Add tangent relationships to the arc to fully define it. The arc must be coincident to 
the end of the first sketch, which is also visible in figure 3. 

 

Figure 3 Creating the second sketch on the Front plane. 
14. Exit the second sketch. 

15. Start a new sketch on the Right plane and create a sketch shown in figure 4, which 
shows the completed sketch as seen from a Right  view. Once again, tangent 
relationships between the arc and adjacent geometry are critical to the design intent 
of the model. Make sure the start-point arc is coincident to the endpoint of the line in 
the second sketch. 

Figure 4. Developing the third sketch. 
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16. Exit the third sketch. 

A plane will be created for the next sketch, and the sketch geometry itself will be 
slightly more complex. A construction circle will be used in this next sketch, which 
will serve two functions. It will serve to define the location of an arc, and it will be 
used to define a circle for the helix. Continue with the following steps to see how 
this will pan out. 

17. Click Plane on Reference Geometry Toolbar. Define a plane using the Parallel 

Plane at Point  option. Select the point and Top plane for Selections  as 
shown in Figure 5. 

 

Figure 5 Reference plane parameters. 

Select this point

18. Plane 1 will appear in Feature manager Design Tree. Rename the new plane as 
Helix_ Plane. 

19. Select Helix_ Plane, click sketch   and then click Top on Standard View 
Toolbar. 

20. Draw a circle  with center at origin. Check For construction box in Circle 
Property Manager. Circle will be converted to construction circle. Dimension it as 
3.6 in.  

21. Add two arcs as shown in Figure 6. First arc is tangent to Sketch3, second arc is 
tangent to first arc and its radius is equal to construction circle. Add proper relations 
to fully define this sketch. Figure 7 shows the same sketch viewed as isometric.   

                          
Figure 6 Developing the fourth sketch.        Figure 7 Fourth sketch’s isometric view. 
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22. Exit the sketch. 

23. Start a new sketch  on the Helix_Plane once again.  

24. Select the construction circle from the fourth sketch and convert it to a sketch circle 

by clicking on the Convert Entities  sketch tool. The construction circle will be 
converted into a regular circle at this point. 

25. Enter the Helix  command. 

26. Use the following parameters to define the helix: 

    —    Pitch = .75 inch 

— Revolution = 3  

— Starting angle = 270 degrees 

— Clockwise is selected 

— Reverse Direction and Taper Helix are both unchecked 

 
Figure 8 Helix curve parameters and helix preview. 

27. Click on OK to create the helix once all parameters have been specified. 

You should now have something similar to that shown in figure 8. FeatureManager 
should list four separate sketches, along with a helix. The helix plane and other 
usual items will be listed also, hut they do not concern us. What needs to happen 
next is to join the four sketches and the helix to form a single curve. 

28. Enter the Composite Curve  command. 

29. Select the four sketches and the helix. This can be done via the work area or 
FeatureManager. (Hint: you can use the flyout FeatureManager by clicking on the 

name of the command, Composite Curve , at the top of PropertyManager.) 
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Figure 9 Composite curve parameters with FeatureManager flyout and preview of 

the composite curve. 

30. Click on OK to complete the composite curve. The result will look similar to 
that shown in Figure 9, but will be a single curve. 

31. Click Plane  on the Reference Geometry toolbar. 

32. Click Normal to Curve  in the dialog box, and then select the Composite curve 
and the upper end point on the composite curve in the graphics area. Preview of the 
plane will appear as shown in Figure 10.  

33. Click OK  to establish the plane. Plane1 will be listed in FeatureManager Design 
Tree. You may leave the same name but rename it as Profile_Plane.   

 
Figure 10 Profile Plane parameters. 

34. Select the Profile_Plane, open Sketch  and draw Circle  with diameter of 
.3125 in. on it. The circle will be used as the sweep profile, and is shown in Figure 
11.  

35. Add a Pierce  constraint between the center of the circle and the helix. It is 
important to select the helix near the end of the helix but not the actual endpoint.  
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Figure 11 Profile Plane with profile sketch. 

36. Exit the sketch. 

37. Enter the Sweep  command. 

38. Select the circle as the Profile  , and the composite curve as the Path  as 
shown in Figure 12. 

39. Leave all default settings and click on OK  to complete the sweep. 

 

 
Figure 12 Sweep parameters. 

40. The final feature should look similar to that shown in figure 13.  
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Figure 13 Candle Holder model as Sweep Feature. 

Feel free to add any other finishing details, or make some modifications to the model if 
you like. For example, you may decide to add a sketch fillet to the first sketch to remove 
the sharp corner from the sweep path. Just make sure you use a radius larger than the 
object being swept (the .3125-inch-diameter circle). You could also add a slight outside 
taper to the helix, or perhaps round off the upper end of the swept feature with a revolved 
feature. This would help keep wax from being scraped off as a candle is rotated into the 
holder. 
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Module 14: Welded Assembly of Lofted Features 
 

1. Open a new part file; check that the units are set to mm. 
 

2. Open a sketch on the ‘Top Plane’ and sketch a circle with a Ø100mm centred 
at the origin. 

 
3. Extrude this sketch to a thickness of 12mm. 

 
4. Select the ‘Top Surface’ of the Flange and add a 3mm fillet. 

 
5. Open a sketch on the ‘Top Surface’ of the Flange and draw a vertical centre 

line up from the origin.  See Figure 1. 
 

 
Figure 1 

 
6. Select the ‘Hole Wizard’  from the ‘Features Toolbar’.  The ‘Hole 

Definition Window’ opens. 
 

• Choose the ‘Countersink Tab’. 
• For ‘Standard’ choose ‘ISO’. 
• For ‘Screw Type’ choose ‘CTSK Flat Head’. 
• For ‘Size’ choose ‘M8’. 
• For ‘End Condition & Depth’ choose ‘Through All’. 
• Leave all other values as default sizes. 

 
See Figure 2. 
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Figure 2 

 
7. Select the ‘Next’ button.  The ‘Hole Placement’ window opens.   

 
Note the symbol on the cursor.   
 

 
Figure 3 

 
Place the cursor on the centre line as shown in Figure 3.  
 
Notice that the centre line changes to red. 
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8. Right click and choose ‘Select’.  Choose the dimension tool and add the 
distance from the origin to the hole centre.  This distance should be 35mm. 

 

 
Figure 4 

 

 
Figure 5 

 
9. Select ‘Finish’ from the ‘Hole Placement’ window.  The hole is generated 

and the feature is added to the design tree.  See Figure 4 & 5. 
 

10. We will now add 5 more countersunk holes creating a ‘Circular Pattern’ of 
the first hole.  Choose the ‘Circular Pattern’  button. 

 14-3



 
Figure 6 

 
11. The ‘Circular Pattern Property Manager’ opens.   

 
Note that the first hole is already listed in the ‘Features to Pattern’ field. 
 
From the ‘View’ drop down menu select ‘Temporary Axes’.  Select 
‘Isometric’ to get a better view of these axes.  For the ‘Pattern Axis’ field 
(the pink field) choose the centre line in the middle of the Flange (not the 
centre line in the middle of the hole).  Ensure that the equal spacing box is 
ticked and that the angle is 360º.  Increase the number of instances from 2 to 6.  
You may use the ‘up’ arrow and watch the yellow preview indicating the 
result as more holes are added.  When all six holes are shown, select OK to 
complete the command.  The circular pattern of countersunk holes is added to 
the Flange and listed in the design tree.  See Figure 6. 
 

12. Switch off the ‘Temporary Axes'.  Right click on the centre line sketch and 
choose ‘Hide Sketch’.  The Base Flange is now complete. 

 
13. Use ‘Save As’ and save the ‘Flange’ for later use.  You may close the file. 

 
14. Open a new part and save as ‘Lofted Column’.   

 
15. Activate the ‘Top Plane’ and choose ‘Isometric’ . 

 14-4



 
Figure 7 

 
16. Hold down the control key and create a new plane parallel to the Top Plane 

and at a distance of 76mm above it.  See Figure 7. 
 

17. Open a sketch on the Top Plane and sketch a circle of Ø42 centred at the 
origin. 

 
18. Open a sketch on the upper plane (plane 1) and sketch a circle of Ø32 centred 

at the origin.  See figure 8. 
 

 
Figure 8 
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19. Select the ‘Loft’  button from the ‘Features Toolbar’.  Ensure that ‘Show 
Preview’ is checked under options in the ‘Loft Properties Manager’.  Select 
the lower circle at any point on its circumference.  The point is highlighted on 
the sketch and is listed in the pink profiles field of the ‘Loft Properties 
Manager’. 

 
20. Select the upper circle circumference at approximately the same position as 

the lower one.   
 

 
Figure 9 

 
A solid loft is generated between the two sketches and the second sketch is 
listed in the pink profiles field.   

 
21. Select ‘OK’   to complete the command. 

 
22.                                SAVE YOUR WORK!!! 

 
23. We can now weld all the parts together.  Open the ‘Hand Rail Column Top’, 

the ‘Flange’ and the ‘Lofted Column’.   
 

24. Choose ‘New’   and select ‘Assy’ .  
 

25. From the ‘Window’ drop down menu choose ‘Tile Horizontally’.   
See Figure 10. 
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Figure 10 

 
26. We can now begin the procedure for joining these parts together by welding. 

 
Place the ‘Hand Rail Column Top’ into the Assembly first.  This first part 
will be the ‘Anchored Part’ of the assembly.  From the top of the design tree 
drag the ‘Hand Rail Column Top’ icon into the design tree area of the 
assembly window.  Remember to hold the left button down as you drag and 
drop.  Drag the other two parts from the top of their design trees and drop 
them in the graphics area of the assembly window.   

 
27. Maximise the assembly window.  To see the parts more clearly choose 

‘Isometric’  .  See figure 11. 
 

 
Figure 11 
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28. We will now mate the base of the lofted feature to the top surface of the 
flange.  Select ‘Mate’ from the ‘Assembly Toolbar’.  Choose the Top Surface 
of the flange to activate it and to list it in the ‘Entities to Mate’ field of the 
‘Mate Properties Manager’. 

 
29. Use the ‘Rotate’  button and choose the bottom of the lofted feature.  

Select ‘Coincident’   and ensure that ‘Closest’ is checked. 
 

30. We will now make these two cylindrical parts concentric.   
 
Select the circular base of the Flange.  Hold down the control key and select 
the circular base of the lofted feature.  Choose ‘Mate’ once again; note that 
the two surfaces are listed and that the concentric mate is now available.  Mate 
these two features to each other.   
 

 
Figure 12 
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Figure 13 

 
31. We must now mate these two parts to the bottom surface of the final part.   

 
Use ‘Mate’ ‘Coincident’   to align the top surface of the lofted feature with 
the bottom surface of the final part.  See Figure 14. 
 

 
Figure 14 

 
32. In the design tree select the ‘Origin’.  From the ‘View’ drop down menu, 

switch on ‘Temporary Axes’. 
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33. Select ‘Mates’ note that the origin is already listed in the ‘Entities to Mate’ 
field.  Select the vertical axis through the lofted feature and choose 
‘Coincident’ and Preview’ in the ‘Mate Property Manager’.  See Figure 15. 

 

 
Figure 15 

 

              
     Figure 16 

 
Notice that all parts are now correctly positioned and ready for welding. 
Figures 15 & 16.   
 
Switch off the temporary axes. 
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SAVE YOUR WORK!!! 

 
34. From the ‘Insert’ drop down menu navigate to ‘Weld Bead’.  See Figure???  

The weld bead window opens.  The most suitable weld here is the ‘Fillet 
Weld’.  Choose ‘Fillet’ from the ‘ISO’ ‘Weld Types’ offered in the window 
and choose ‘Next’.  

 

 
Figure 17 

            
Figure 18 

 
(Note the weld symbol and the pictorial diagram change as you make 
selections.)   
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• For ‘Surface Shape’ choose ‘Concave’. 
• For ‘Top Surface Delta’ increase the value to 0.75. 
• For ‘Radius’ increase the value to 5mm. 
 

When the above changes are in place choose ‘Next’.   
 

 
Figure 19 

 
We must now select the surfaces to be welded.   
 
Select the top surface of the Flange and the cylindrical surface of the Lofted 
Column.  These two surfaces are listed in the pink ‘Contact Faces’ window.  
Choose ‘Next’ and ‘Finish’.  The weld is generated between the two parts and 
is added to the design tree.  See Figure 20. 
 

 
Figure 20 
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35. With the ‘Rotate’   tool manoeuvre the model so that the under surface of 
the model is visible and apply the same weld between the Top of the lofted 
column and the bottom of the other piece.   

 
You will find however that the 5mm radius is too big for a weld at this 
location.   
 
Use the back button to return to the appropriate window and reduce the radius 
to 3mm.  The weld will now be satisfactory.  See Figure 21. 
 

 
Figure 21 

 
SAVE YOUR WORK!! 
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Module 15: Inserting Standard Parts from the ‘Toolbox’ 
 

1. Open the ‘Hand Rail Column’ assembly file. 
 

2. Open the ‘Hand Rail Column Cap’ part file. 
 

3. Drag & drop the ‘Cap’ into the ‘Assembly’ file. 
 

4. Use ‘Coincident’  and ‘Concentric’  Mates to align the Cap with the 
Main Part.  

 

 
Figure 1 

 
 

5. Use ‘Move Component’ to position the Cap as shown in Figure 1.  
 
The parts are now aligned so that a standard Bolt, Nut and Lock Nut may be 
added.  We may gain access to the ‘Toolbox Browser’ by selecting the tab at 
the bottom of the ‘Feature Manager Design tree’.  See Figure 2. 
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Figure 2 

 
6. When the ‘Toolbox Browser’ is open we may drag and drop many ‘Standard 

Parts’ into an assembly.  In this exercise we are going to use a standard M12 
x 65 lg. Bolt, Nut and Lock Nut.  At the top of the Toolbox Browser there are 
three drop down windows that are used to navigate to the parts we require.  To 
drag and drop these parts we must put some settings in place; 

 
• Choose ‘ISO’ from the ‘Catalog’ window (top window). 
• Choose ‘Bolts and Screws’ from the ‘Chapter’ window 

(centre window). 
• Choose ‘Hex Bolts and Screws’ from the ‘Page’ window 

(bottom window). 
 

7. With the ‘Rotate’  button, manoeuvre the parts so that you can see the bolt 
hole in the main feature.  See Figure 3. 
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Figure 3 

 
8. Drag a ‘Hex bolt Grade AB (4014)’ from the Toolbox Browser to the 

graphics area and drop it into the bolt hole of the main part.   
 

The software will apply a ‘Smart Mate’ between the hole and the bolt and you 
will see the bolt snap into place. 
 

9. The bolt dialog box appears.  Set the parameters of the bolt as follows; 
 

• Size  ‘M12’ 
• Length  ‘65’ 
• Thread Length ‘30’ 
• Thread Display ‘Schematic’ 
 

Left click OK to add the bolt to the assembly.  See Figures 4 & 5. 
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Figure 4 

 

 
Figure 5 

 

 15-4



           
Figure 6 

 
10. Select ‘Isometric’ .  You can now see the Bolt passing through the two parts.  

See Figure 6.  From the ‘Chapter’ window choose ‘Nuts’.  The ‘Page’ is 
automatically selected and opens at ‘Hex Nuts’.  Drag a ‘Grade C (4034) Nut 
into the assembly and drop it on the edge of the hole where the bolt protrudes.  
Set the parameters of the nut to suit those of the bolt; 

 
• Size  ‘M12’ 
• Thread Display ‘Schematic’ 

 
Left click OK to add the nut.  See Figures 7 & 8.   SAVE YOUR WORK!!! 

 
Figure 7 
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11. Drag a ‘Thin (Chamfered) (4035)’ Nut and drop in the graphics area of the 

screen.  Once more enter the nut parameters to match the standard nut.  Click 
OK to place the nut near to the assembly.  See Figure 8. 

 

 
Figure 8 

 
12. Mate the locknut coincident to the end face of the Standard Nut and concentric 

with the bolt.  See Figures 9, 10 & 11. 
 

 
Figure 9 
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Figure 10 

 

 
Figure 11 

 
13. The assembly is now complete.  See Figure 12.  SAVE YOUR WORK!! 
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Figure 12 

 15-8



Module 12: Sweep Features I; Cranking Lever 
The cranking lever details are shown in Figure 1. 

 
Figure 1 Cranking lever  

It can be modeled by the following steps as shown in Figure 2. 

   
 

   
Figure 2 Cranking lever modeling process.  

1. Create a cranking lever head using a revolved boss/base feature. 

2. Create a crank lever head with an extruded boss/base and revolved cut 

3. Add a handle to the handle body using the revolved boss/base. 

4. Create two ribs fillets on the crank lever. 
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Create a Cranking Lever Head 
1. Start SolidWorks. 

2. Select New  on the Standard toolbar, or click File, New on the menu bar. 

3. Select Part  from the Template tab in the dialog box, and click OK. 

4. Click File, Properties on the menu bar. 

5. Fill in the necessary properties in the dialog box, and click OK to accept the 
properties and close the dialog box. 

6. Click Tools, Options on the menu bar to open the option dialog box. 

7. Select the Document Properties tab. 

8. Click Unit in the properties tree text box. 

9. Select Millimeter and set the decimal places to 2. 

10. Click OK to close the Properties dialog box. 

11. Select Sketch  on the Sketch toolbar to open a new sketch on the Front Plane. 

12. Select Centerline  on the Sketch Tools toolbar to draw a vertical centerline 
through the origin as the axis of the revolution. 

13. Select Line  on Sketch Tools toolbar, and draw and dimension a profile of the 
cranking lever head as shown in Figure 3. 

 
   Figure 3 Cranking Lever Head Sketch 

14. Select Revolved Boss/Base  on the Features toolbar, and click OK . 

15. Select the Front  plane on the FeatureManager design tree. 

16. Select Sketch on the Sketch toolbar to open a new sketch for the lever head rib. 

17. Click Normal To  on the Standard Views toolbar to make the sketch plane 
parallel to the screen. 

18. Sketch and dimension the lever head rib as shown in Figure 3. 
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Figure 3 Lever head rib sketch. 

19. Select Extruded Boss/Base  on the Features toolbar. 

20. Select Mid Plane on the End Condition drop down list box. 

21. Type 10mm in the depth box under Direction 1, and click OK . 

22. Select the top surface of the rib as shown in Figure 4, and open a sketch. 

 
Figure 4 Sketch plane for lever head ear. 

23. Sketch and dimension the lever head ear as shown in Figure 5. 

 
Figure 5 Lever Head Ear Profile 
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24. Select Extruded Boss/Base  on the Features toolbar. 

25. Enter 13 mm in the depth box under Direction 1 as in Figure 6. 

26. Click OK .      

 
Figure 6 Lever Head Ear Extrusion 

Create a Handle Body using Sweep 
1. Select the Front on the FeatureManager design tree. 

2. Select Sketch  on the Sketch toolbar to open a new sketch for the sweep guide 
curve. 

3. Sketch and dimension the sweep guide curve as shown in Figure 7. 

 
Figure 7 Sweep path 

4. Click Confirmation Corner or select Rebuild  on the Standard toolbar to 
exit the sketch. 

5. Select Front on the FeatureManager design tree. 

6. Select Sketch  on the Sketch toolbar to open a new sketch for the sweep guide 
curve. 

7. Sketch and dimension the sweep guide curve as shown in Figure 8. 
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Figure 8 Sweep guide curve. 

8. Click Confirmation Corner or select Rebuild  on the Standard toolbar to 
exit the sketch. 

9. Select Insert, Reference Geometry, Plane on the menu bar or Click Plane  on 
Reference Geometry Toolbar. 

10. Click the Offset Distance  button. 

11. Select the Right plane on the FeatureManager design tree, and enter 230 mm in the 

Distance  box. 

12. Check the Reverse direction check box as shown in Figure 9. 

 
Figure 9 Reference plane for sweep profile 

13. Click OK . 

14. Select the Plane1 on the FeatureManager design tree or in the graphic window. 

15. Select Sketch  on the Sketch toolbar to open a new sketch for the sweep profile. 

16. Sketch a rectangle. Then, sketch 2 points on the middle of the horizontal edges. 

17. Click Add Relation  on the Sketch Relation toolbar. 

18. Apply Midpoint  constraint to these two points. 
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19. Select the sweep path, and the bottom point, and apply Pierce  constraint as 
shown in Figure 10. 

 
Figure 10 Pierce Constraints between Profile and the Path 

20. Select the guide curve, and the top point, and apply Pierce  constraint as shown 
in Figure 11. 

 
Figure 11 Pierce Constraint between Profile and Guide Curve 

21. Dimension the width of the rectangle to 64 mm as shown in Figure 12. 

 
Figure 12 Profile dimension 
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22. Click Confirmation Corner  or click Rebuild  on the Standard toolbar to 
exit the sketch. 

23. Select Sweep Boss/Base  on the Features toolbar. 

24. Select the path (Sketch 4) in the path  box under the Profile and Path frame. 

25. Select the guide curve in the Guide Curves 4 box as in Figure 13. 

 
Figure 13 Sweep parameters. 

26. Select OK . 

27. Select the bottom surface of the lever head as shown in Figure 14, and open a sketch. 

 
Figure 14 Sketch plane for lever handle cut. 

28. Select the head circle, and click Convert Entities  on the Sketch Tools toolbar 
to create a circle on the sketch plane. 

29. Sketch three lines, and Trim  the circle to form the cut profile as shown in 
Figure 15. 
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Figure 15 Lever Body Cut Sketch 

30. Select Add Relation  on the Sketch Relations toolbar. Select the arc and the 

angled line, and apply a Tangent  constraint to them. 

31. Dimension the sketch as shown in Figure 16. 

 
    Figure 16 Lever body cut profile 

32. Select Extruded Cut  on the Features toolbar. Select Through All on the end 

condition drop down list box, then click OK  

33. Select the last Feature created in FeatureManager Design Tree, i.e., Cut-Extrude 2, 
you may or may not have a different name for this Feature.  

34. Select Mirror  on the Features toolbar. The body cut (Cut-Extrude 2) should 
be selected as the mirror feature. If not, select it. Then select Front plane on the 
FeatureManager design tree as the mirror plane.  

35. Click OK  to mirror the cut to the other side as shown in Figure 17. 

 
    Figure 17 Lever body 

 

Create Lever Handle and Head Hole Using Revolved Features 
1. Select the Front plane on the FeatureManager design tree to open a sketch for the 

lever handle. 

2. Sketch and dimension the profile as shown in Figure 18. 
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Figure 18 Lever handle profile. 

3. Select Revolved Boss/Base  on the Features toolbar. 

4. Click OK  to create the revolved lever handle. 

5. Select the Front plane again in the FeatureManager design tree to open a sketch for 
the head hole cut. 

6. Sketch the hole cut profile as shown in Figure 19. 

 
Figure 19 Head hole profile. 

7. Select Revolved Cut  on the Features toolbar, and Click OK  create the 
head hole 

 Create Handle Rib and Fillets 
1. Select the Front plane in the FeatureManager design tree to open a sketch for the 

rib. 

2. Sketch and dimension the profile using Line  as shown in Figure 20. 
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Figure 20 Handle rib profile. 

3. Select Rib  on the Features toolbar. Select Both Sides , enter 10 mm in the 
Rib Thickness  box and check Flip material side as shown in Figure 21. 

4. Click OK  to create the rib. 

 
Figure 21 Handle rib parameters. 

5. Select Fillet  on the Features toolbar, and enter 2 mm in the Radius  box. 

Select edges around the rib edges, handle edges as in Figure 22. Then click OK  
to create fillets. The final model for Cranking Lever is shown in Figure 23. 

6. Save the Model. 

         
        Figure 22 Cranking Lever fillets.  Figure 23 Cranking Lever model. 
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